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1.1 - Opening the app

Go to your Applications folder and double click on Typelt4Me.
The first time it launches, you will be presented with a window titled
“Please allow Typelt4Me to control your computer” (pictured right).

Accessibility access needs to be enabled in order for Typelt4Me to
expand abbreviations as you type. Click OK to be taken directly to
the Accessibility pane in System Preferences, then click the padlock
and if prompted, enter your administrator password*. Finally, tick
the checkbox next to Typelt4Me and log out or restart your Mac
so that the setting can take effect.

Please note: until you grant Typelt4Me this accessibility permission,
expansion will *not* work when you type abbreviations with the
keyboard.

It will *only* work when you point and click on your abbreviations in the

TypeltdMe menu bar dropdown list.

*If you don’t know your password, this Apple support page may be of some help:

Please allow Typelt4Me to control your computer

Typelt4Me's accessibility permission
is currently switched off.

If you want Typelt4Me to expand abbreviations as
you type, you need to allow it to "control your
computer"”.

Clicking the OK button below will take you to the
Security & Privacy System Preferences. Once there,
click the lock at bottom left to make changes and enter
your Mac login password when prompted (if you don't
know what it is, ask the person who helped you set up
your Mac). Then tick the checkbox next to Typelt4Me.

You'll need to log out or restart to make the change
take effect. Once you've done that, Typelt4Me will be
able to expand abbreviations as you type.

OK

000 < Security & Privacy Q s
General  FileVault  Firewall o)

computer

‘ Contacts

() cotencrs @ <.) TypeltdMe.app

SALAME
pe
Steny!
[ Click the lock to make changes. vancse. 12

_—

I'm not interested in abbreviation expansion. Don't show this again.




1.2 - Getting acquainted with text expansion

Typelt4dMe is a text expander. Text expansion is essentially on-the-fly substitution of short

typed abbreviations with longer ‘snippets’ of content, which can include lengthy words, phrases,
boilerplate texts or even pictures. Whenever you type a pre-defined shorthand abbreviation of your
choosing, Typelt4Me instantly replaces it with its corresponding snippet.

e0e ) TypeltaMe Once you've granted the necessary accessibility permission outlined in section
A=A A 5 1.1, launching Typelt4Me will bring up the main window (pictured). This is where
Preferences Print Help Stats Register . e .
you’ll customise the app to your liking and define your own personal shorthand. To
Sete om the Mac: 1 give you some inspiration, we’ve included a few dummy abbreviations you can
play with while you get to grips with how everything works. When you type these
in almost any app that accepts text input, they’ll expand to common greetings,

V¥ Selected set: Examples (25 snippets)

+[— . . .
contact details and phrases - ‘snippets’ of text and / or images.
Snippets selected: 1 of 25 Abbreviation: Label:
App  Abbreviation Snippet hmadd Home address
A br Best regards,
B, ds Dear Sir, Snippet contents:  Plain text H
A eml me@ettoresoftware.com 123a Home Street, . ) ) .
g [ess Ettore Software Limited Springfield, XY 43210 How about trying one of the examples out? With Typelt4Me running, switch to
e e your text editor of choice and type . As soon as you type a space after it,
A 4
A Ifwd 'm looking forward to it this should instantly become: X
A lor Lorem ipsum dolor sit amet
A mynum 1-408-12345678910
+ = = Q Insert a Format <
Preferred menu display style of the selected snippet(s): Default E
Version 6.0 (124) *If this doesn’t happen, it’s possible you didn’t grant Typelt4Me the accessibility permission it

requires for keyboard expansion, or you forgot to log out or reboot your Mac after doing so.
Check the troubleshooting section at the end of this user guide.




Still with us? Great. Text expansion is a fantastic time saver. Hopefully,
you’ve enjoyed typing the examples and watching reams of text content
magically materialise in the blink of an eye. If so, you'll be pleased to learn
the fun doesn’t stop there.

In addition to expanding abbreviations typed on the keyboard, A B LR R o
Typelt4Me offers a handy point-and-click option. If, like us, you 7y s ‘ ‘ e PR
occasionally forget what abbreviation you assigned to a particular - A e ¢ R
snippet, or even if you simply don’t feel like typing it, you can scroll - (PR raferances..
through the Typelt4Me menu bar list and click on it, as shown here B 2% > Pause

(right). Doing so will insert the snippet contents wherever the 7 ' - _
cursor is currently positioned in the app you’re using. B o Z::;:ZT:TSEQ"““E ¢

Work email address
Company name

Home address

Hello there,

All good so far? Congratulations, you'’ve installed Typelt4Me on
your Mac and it’s working as intended. Feel free to try out some of IS— -
the other pre-defined abbreviations in the Examples set to get a -
feel for things before we move on. In the next section of this guide,

we’ll look at ways to define your own abbreviation / snippet pair.

I'm looking forward to it Ifwd



1.3 - Defining your first abbreviation / snippet pair

OK, we'’ve had a play with the provided examples and explored the delights of text expansion, so by now you’re
probably champing at the bit to start defining your own shorthand abbreviations. Let’s get down to business.

First, you'll want to create your own snippet set, i.e. a file that will contain a new
group of snippets. Do this by clicking the + button below the bottom left corner of the
“Sets on this Mac” pane (pictured right). When prompted, give your new set a name
(“My Snippets”, perhaps) and click Done.

[ ] Typelt4Me
—
Preferences Print Help Stats Register

V Selected set: Enter a name for your new set:

Sets on this M 4

{ My Snippet
Examples v
Cancel



Once you’ve saved your newly created snippet set, you’ll see it appear in the list,
along with the bundled Examples set. You'll notice it’s highlighted, which means it’s
now the selected set. All the snippets in the selected set are displayed in a list
below. You'll also notice a ticked checkbox to the left of the set name. This means
it’s “active” or, in other words, enabled. If later you want to temporarily disable the
set, so snippets it contains won’t expand when typed, just untick its checkbox.

Unlike in older Typelt4Me versions, multiple sets can be active at the same time.
You can easily toggle them on and off as and when you need them. You can also
drag sets to re-order them. Sets higher in the list take priority over the sets below.
If the same abbreviation is present in more than one set, the one in the topmost
set in the list will be expanded when you type that abbreviation.

You don’t have to use multiple sets. The option is simply there for anyone who
prefers to organise different snippet types into separate groups, for use in very
specific contexts or applications.

Looking further down, you’ll see that the list of snippets is now empty save for one
abb / snippet pair. This is a placeholder that is created by default. Try typing in
your favourite word processor or in the body of an email (or just about anywhere
else). As soon as you type a space* after it, the word (i.e. your abbreviation)
will be replaced by the word

*Later in this guide you'll learn how to change the expansion ‘trigger’ from a space to an alternate
punctuation key if that suits you better. You'll also learn to fine tune your preferences to specify
whether the character that triggered the expansion should be included at the end of the expanded
shippet or dropped.

1 = O Ll .

Preferences Print Help Stats Register

V Selected set: My Snippets (1 snippets)
Sets on this Mac: 2

Examples

v My Snippets

+_

Snippets selected: 1 of 1
App Abbreviation Snippet

N abb snippet



1.3.2 Define a new abbreviation via the main app window

Now that we’ve observed the snappy way Typelt4Me expands abb to snippet,
it’s time for you to redefine both abb and snippet to something more useful.

If you often type the phrase “Thank you so much”, you might want to type
tysm and have that expand to Thank you so much. Let’s try that, shall we?

First, click on the newly created abb / snippet entry in the list to select it.

Snippets selected: 1 of 1
I App  Abbreviation  Snippet

- NS

| \

Next, press the = (tab) key. This will move the focus to the abbreviation field.

reviation: Label:
’ m Enter a label

Snippet contents:  Plain text

snippet

Page 13 of 102



Now you can overwrite by typing in the abbreviation field...

...and press the -1 key again to move to the
Label field. Here you can choose to give your
shippet a descriptor, but you don’t have to
Snippet contents:  Plain text enter anything. While it can come in handy
for summarising the content of your longer
boilerplate snippets, for words and short
phrases you may want to just leave it blank.

Abbreviation: Label:

tysm

Press — once more to progress to the eviation: Label:

main snippet content editing field*. tysm

You'll notice the placeholder is

hi . Snippet contents:  Plain text [T
ighlighted, ready for you to type over

it with your new content. snippet ‘

*You may be asking yourself “What’s that pulldown menu in between, though?” Great question. That’s where you can
choose to create a special kind of snippet that will contain rich text formatting and / or pictures. We’ll come back to that

and look at it in more detail later in this guide. Don’t worry about it for now.

on:

Label:



Type the phrase

| NON

= NI

Preferences Print Help Stats Register

V Selected set: My Snippets (1 snippets)
Sets on this Mac: 2

Examples
My Snippets

+_

Snippets selected: 1 of 1
App  Abbreviation Snippet

A tysm Thank you so much

+[-] [=+] | a

Preferred menu display style of the selected snippet(s):

in the main content editing field.

Typelt4dMe

Abbreviation: Label:
tysm
Snippet contents:  Plain text [T

Thank you so much|

Insert | <) Format

Default | T] Save

Version 6.0 (124)

You’ll then want to save the new snippet you’ve just created. There are
three ways to save changes to a snippet. You can:

* Use the 3-S keyboard shortcut.
* Click anywhere in the adjacent list of snippets.

* Click the Save button in the bottom right corner of the app window.

All done? That was easy peasy, wasn't it! You've just defined a new
abbreviation / snippet pair without even breaking into a sweat. Now,
every time you type in almost any Mac app in which you can
type, it will expand to . Go ahead and create as
many new abbreviation / snippet pairs as you need. Add new ones or
delete existing ones using the + and - buttons below the snippets list.
You can also use the 3-N keyboard shortcut to start a new snippet.



1.3.3 Define a new abbreviation via the Add a Snippet shortcut

We’ve shown you one way to define a new abbreviation and you’ve grasped the nettle with gusto.
But wouldn't it be great if instead of doing it that way you could select some existing text, then create
a snippet and its abbreviation without having to re-type it? Good news: you can do exactly that.

[ NON ) L& \ Eji\ = www.bbc.co.uk/t |

u

The Apple Macintosh sold 50,000 units in its four months on sale
at $1,995.

In the run up to the launch of the Apple Macintosh Steve
Jobs demonstrated his mastery for public engagement
and building hype.

He hired film director Ridley Scott to make Apple’s ‘1984’
advert, and gained huge publicity by pitching Apple as a
rebel outsider taking on the computer giant IBM. He
secured interviews and features in magazines across
America. The launch was masterminded by Jobs, though
Apple CEO John Sculley said “he was driving people
insane” with his perfectionism. He demonstrated the

Imagine you are browsing in Safari and there’s some text in a web page discussing
Steve Jobs’ myriad successes that you want to add to your collection of snippets.
For instance, you may want to abbreviate “Apple Macintosh” and have it come up
whenever you type the letters Appl.

Begin by selecting and copying to the clipboard the text you want to abbreviate: in
this case, Apple Macintosh (pictured left). Next, pull down the Typelt4dMe menu and
click on the Add a Snippet... option as shown below.

About TypeltdMe
Help
Check for updates

This lets you add a snippet, taking any text on f
the Clipboard as a starting point. Add a Snippet...

"

Manage Snippets...
Preferences...

Pause
Quit

Examples
My snippets

PR
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A window will come up prompting you to add a snippet with as
its abbreviation (pictured right). By default, Typelt4Me uses the first
four letters on the clipboard to suggest the abbreviation, but you are
of course free to change this to something better / more memorable.
Add a descriptive label if you like, then pick the set to which the new
shippet should be added (it will default to the currently selected set).
When you’re done, click the Add this Snippet button and dismiss the
window. Just remember, if you want to add pictures, you’ll need to
click the Rich text radio button, as illustrated below.

Abbreviation: Plain text

Appl| © Rich text

Pretty painless, all in all, no? You may want to consult the Reference

section to learn how to define a hot key for adding a snippet this way.

It'll save you reaching for the menu bar. Otherwise, you now know
the basics of how to use Typelt4Me. Feel free to get stuck in and
come back to this guide later when you have specific questions or
you want to learn how to craft more advanced snippets.

[ ) Typelt4Me
Preferences Print Help Stats Register
VvV Se o
Add a snippet
Sel
Ex Abbreviation:
My [YEER: © Plain text Applescript
| Appl Rich text / picture [
+ |- =+
| Snippet Contents: |
Apple Macintosh
Please |
App 4
A C
Label: Set:
My snippets (local) d
Cancel Add Snippe
+

Default

Version 6.0 (124)




2.1 - What is Typeltdme?

Typelt4Me is a text expander. Text expansion is essentially on-the-fly substitution of short typed
abbreviations with longer ‘snippets’ of content, which can include lengthy words, phrases,
boilerplate texts or even pictures. Wherever you type a shorthand abbreviation of your choosing,
Typelt4Me will instantly replace it with a corresponding snippet that you've defined.

The very first text expander developed for Mac OS, Typelt4Me is an app designed to accelerate
your typing by rapidly replacing your custom defined abbreviations with longer ‘snippets’ of text
and / or pictures as you go. Once installed and launched, it silently runs in the background to help
you type more quickly and accurately.

Find yourself typing the same things over and over? Build up a set of abbreviations and the full
text / image ‘snippets' that they represent. Typelt4Me will save you time and keystrokes by
automatically expanding them while you continue typing. This works systemwide, in almost any
app in which you can type.



2.2 - “How might | use TypeltdMe?”

How you use Typelt4Me will depend on who you are and what you often find yourself writing. It's
popular with doctors, transcriptionists, lawyers, customer support teams, coders, journalists, authors
and bloggers, to give just a few examples.

Things Typelt4Me can help you knock out more quickly include:

+ people’s names, email addresses and other contact details
+ commonly repeated phrases

+ awkwardly lengthy / difficult-to-spell medical terms

+ boilerplate clauses for legal contracts

+  “Have you tried turning it off and on again?” IT support replies

It can be particularly useful for entering repetitive data in a database file or spreadsheet, or for
anyone who finds him or herself frequently typing the same things over and over.

Many people find Typelt4Me useful for speedily inserting the current date and a return address when
composing letters. It’'s handy for email sign-offs, too. For example, you might type just br to get:



As developers, we use Typelt4me ourselves to type standard phrases when providing email
support for our software. It’s great for programming, too. Abbreviations don't have to be shorter
than the text they type. For example, we’ve defined (5 letters long) to 'expand' to a single
character (~), which is often needed in C programs, yet always seems to disappear from the
keyboard when it’s most needed.

Typelt4Me can save you having to switch keyboards to type in other languages and use special
characters, accents or symbols. For instance, a US keyboard may not have a readily accessible
Euro symbol, so could 'expand' to €. When typing in French, ag could become 2 (a with an
accent grave). You may find this much easier than typing alt-" + a, or switching between
international keyboards or long-pressing to pick from an accented character pop-up.

By defining a set of mnemonic abbreviations for most frequently used words, you can type
speedily yet more accurately and with less effort. Typelt4Me will save you keystrokes and
potentially alleviate repetitive strain injury :)

For example, could swiftly produce (if you have
defined u=you, r=are, rh= , ab= , th=the and = )



2.3 - An overview of the main Typelt4Me app window

The main app window comprises three core sections. The toolbar is where

you’ll access preferences, print options and help (i.e. this user guide). You can

also bring up statistics detailing approximately how much time Typelt4Me has

saved you. While you are using the app in fully functional demo mode, there - o000 TypeltaMe
is a registration button for when you’re ready to purchase and enter a licence i é () |_ ;J

code. That will go away once you'’ve registered. fisferences mRdntmticin e Stots pRcoister

V¥ Selected set: Examples (25 snippets)

Sets on this Mac: 2

v Examples

My Snippets

Below the toolbar is a shallow segment where you’ll create and manage your +|—
snippet “sets” - data files that contain your snippets and their corresponding N
.. L. .. . [ Snippets selected: 1 of 25 Abbreviation: Label:
abbreviations. This is divided into locally stored sets on the left and remote App | Abbreviation | Snippet hmadd Home address
H H br Best regards,
sets on the right (more on this later). : — i S onetesniantat Piain toxt .
A eml me@ettoresoftware.com 123a Home Street,
A €S0 Ettore Software Limited Springfield, XY 43210
A hmadd 123a Home Street,
A | ht Hello there,
The deeper bottom segment is where you'll create and edit your snippets. A | ffwd 'm looking forward to it
A lor Lorem ipsum dolor sit amet
2

In the left half is a list of the snippets contained within the currently selected mynum  1-408-12345678910

set. Select one and its contents will be displayed as a large editable preview - _“"’"Ev ‘“"2 Annlication *Finder® _— B e
in the large pane on the right. Above and below these panes are buttons and

controls for adding, removing, editing, labelling and sorting your snippets, as
well as an assortment of menus for controlling their individual behaviours

Preferred menu display style of the selected snippet(s): Default u

Version 6.0 (124)

and crafting more advanced expansion tricks.



2.4 - How to create your own custom abbreviations

There are two ways to define an abbreviation and its corresponding ‘snippet’. The first involves selecting some
text, then clicking on Add a Snippet... in the Typelt4dMe menu bar or pressing a hotkey you’ve assigned to that
action. The second entails creating your abbreviation / snippet pair from scratch in the main Typelt4Me app
window. We’ll walk you through both methods.

Suppose you often close your emails with the words . It'd be easy to remember the abbreviation
as shorthand for wouldn't it?

To add this entry to your Typelt4Me snippets set:
type out one last time in your email
select the text and either cut or copy it to the clipboard (36-X or 3-C)
click on Add a Snippet... in Typelt4Me's menu - or press a hotkey you’ve assigned to this action in

Preferences.

This will bring up a window in which you'll be prompted to define a custom abbreviation that will represent the
new shippet that you’re about to create.



By default Typelt4Me will initially suggest that you use the first four letters of the text in the clipboard as your
abbreviation. While this will sometimes be apt, in this case we’d prefer the abbreviation to be kr, so just type that
into the abbreviation field instead. Add a descriptive label if you like, then pick the set to which the new snippet
should be added (it will default to the set you last viewed in the main app window). When you’re done, click the
Add this Snippet button and dismiss the window with a cmd-W shortcut or by clicking the red close button.

[ ] Typelt4Me
Preferences Print Help Stats Register
¥V Se o
Add a snippet
Sel
Exi Abbreviation:
My reviation: © Plain text Applescript
ke Rich text / picture
+ - +
Snippet Contents:
Kind regards,
Please !
App 4
A (]
Label: Set:
My snippets (local) [T
Cancel Add ppe
+

Default

Version 6.0 (124)

...That’s it! From now on, every time you type kr Typelt4Me will instantly
backspace over the abbreviation (kr) and type the full text for you (

).

Please note: if the text you copy to the clipboard is in rich text format
(i.e. it contains font, style and colour information) and you want to
preserve the formatting, make sure the “Rich text” radio button is
checked. This is necessary for those RTF attributes to be saved when
you click “Add this Snippet”. If it's not checked, the snippet will be saved
as plain text, losing any font, style and colour attributes.

In case you are wondering, the Applescript checkbox is for power users
who wish to define snippets that execute actions using Applescript
(more on that later). Clicking the checkbox will insert the special symbol
that will send the contents of the snippet to AppleScript for execution.



Now we’ll look at how to create a kr —> abbreviation / snippet pair from
scratch in the main Typelt4Me app window. Click on Manage Snippets... in the Typelt4Me
menu or press a hotkey you’ve assigned to this action in Preferences. The main
Typelt4Me app window will pop up.

Click the + button in the bottom left
corner or type 3#-N. A new default

/ placeholder entry will
appear in the list of snippets. You'll
note the focus moves to the
Abbreviation text field, with the
placeholder text highlighted ready for

Snippets selected: 1 of 1 Abbreviation: Label: . ) .
App Abbreviation Snippet abb you to replace it with something else.
A abb snippet
Snippet contents: = Plain text w
snippet

Click the
+button... gt




Now you can overwrite by typing

Abbreviation: Label:

ki

Snippet contents:  Plain te»

Press = once more to progress to the
main snippet content editing field*.
You'll notice the placeholder is
highlighted, ready for you to type over
it with your new content.

in the abbreviation field...

...and press the = key again to move to the
Label field. Here you can choose to give your
snippet a descriptor, but you don’t have to
enter anything. While it can come in handy
for summarising the content of your longer
boilerplate snippets, for words and short
phrases you may want to just leave it blank.

Snippet contents:  Plain text [T

snippet

“You may be asking yourself “What’s that pulldown menu in between, though?” Great question. If you want to apply
formatting like colour, bolding or italics to your content and / or include pictures, you must first change the “Plain text”

setting to “Rich text/pictures”.

ton:

Label:



Type the phrase

[ NON ) Typelt4Me
=i
0 — 6 |_ é‘/
Preferences Print Help Stats Register
V Selected set: My Snippets (1 snippets)
Sets on this Mac: 2
Examples
My Snippets
+ —_
Snippets selected: 1 of 1 Abbreviation: Label:
App Abbreviation Snippet kr
A abb snippet
Snippet contents:  Plain text [T}
Kind regards,|
e = Q Insert E Format e
Preferred menu display style of the selected snippet(s): = Default u Save

in the main content editing field.

Version 6.0 (124)

You’ll then want to save the new snippet you’ve just created. There are
three ways to save changes to a snippet. You can:

* Use the 3-S keyboard shortcut.
* Click anywhere in the adjacent list of snippets.

* Click the Save button in the bottom right corner of the app window.

All done? Voila! Now, every time you type kr in a Mac app in which you
can type, it will expand to



2.5 - How do | get something typed for me?

Once you’ve defined your own shorthand in Typelt4Me, there are two ways of triggering automatic insertion
of the text or image an abbreviation represents. The first - usually the quickest and most fluid - involves
tickling the keyboard, while the second is a mouse or trackpad affair. This is how it works:

Type your defined abbreviation, (optionally) followed by a trigger such as a space or punctuation. For

example, type scf for , or for . Typing
could produce . That’s pretty much all there is to it.

In case you’re wondering, if we do define re as an abbreviation for Typelt4Me will not
interfere when we type or or ; it looks for the letters re as a separate word, i.e. preceded and

followed by spaces or by punctuation marks of your choice. It’'s worth noting, mind, that when defining
abbreviations, it's best to avoid potential conflicts with existing words or acronyms. If the first name in the
example above were and not Riccardo, rather than choose be as the abbreviation it would be better to
go with something unique like

If you ever do need to type a letter combo that’s been defined as an abbreviation without it expanding
(perhaps "re your letter dated the 12th..."), pressing the shift key at the same time as the space bar will
prevent the space from triggering expansion. So in our example above re wouldn’t become



Best regards + Signature
Greeting (M)
" Work email address
4 Company name
Home address
Hello there,
I'm looking forward to it
| Latin placeholder text
My work phone num...-408-12345678910 mynum

1 Mail with Zarvox voice opm

About Typelt4Me
Help
Check for updates

Add a Snippet...
Manage Snippets...

Preferences...

Pause
Quit

Examples
My snippets
Accented Words
HTML & CSS
Phone numbers
Place Names
Words & Phrases
| 3

AT

If you click on the Typelt4Me icon in your Mac’s
menu bar you’ll see that the resulting dropdown
lists all of your currently active snippet sets. You
can drill down into each one to reveal the full list
of snippets contained in each. Click the snippet
you want and it will be inserted where the cursor
is positioned in whichever application you're
currently using.

This feature can be useful if you occasionally
forget what abbreviation you assigned to a less
frequently used snippet. Just scroll through the list
to find it, click to insert it and carry on typing.

Once you've defined an abbreviation, as long as Typelt4Me is running in the background it will be available
“on tap” at all times, anywhere text or images can be pasted. It’ll work in your word processor, paint program,
Finder, Contacts, Safari or just about any app you like. Isn’t technological progress grand? Soon we’ll all be
reclining in sun loungers drinking cocktails while the machines do everything for us.



2.6 - What are snippet sets?

In Typelt4Me, a snippet “set” is a file that contains a group of Typelt4Me snippets. These sets are a way for you
to organise and keep different types of snippet separate, should you be so inclined. You can have as few or as
many sets as you like. If you’re only a light Typelt4Me user you might decide to use just a single set containing
all of your snippets. Alternatively, if you have a large number of snippets, you could opt to maintain a number of
different sets, each one suited to a particular context and / or containing a specific category of snippet.

Your available sets are listed at the top of the main Typelt4Me app
window. When the checkbox to the left of a set’s name is ticked, that
means the set is enabled or “active,” i.e. when you type an abbreviation

Selected set: Words & Phrases (20 snippets)

Sets on this Mac: 4 Sets in iCloud Drive: 7

Examples Names & Contact Details

My Snippats crcented Wads from that set it will expand to the full snippet. In older versions of the
Spanish snippets Words & Phrases . .

- R software only one set could be active at a time, but as of Typelt4Me 6.0

multiple sets can now be active simultaneously. You can easily toggle
them on and off as and when you need them, by ticking or unticking the
checkboxes next to the set names. Clicking on a set in the list will
select it and the snippets it contains will be displayed in the list below,
SO you can browse, edit or add to them.

You can drag sets to re-order them. Sets higher in the list take priority over the sets below; if the same
abbreviation is present in more than one set, the one in the set that’s higher in the list will be expanded when
you type that abbreviation. Local snippets in “Sets on this Mac” are treated as ‘higher’ than remote / LAN /
cloud sets and will always take priority over snippets in sets stored in iCloud Drive, Dropbox etc.



We start you off with a bundled Examples set to give you some inspiration and provide some sample
snippets to play with. We also offer some useful pre-cooked sets that you can download from our website
if you wish. You’ll probably want to create your own in which you’ll save the new snippets you define.

Here are just a few examples of how you might use sets:

+  Switch between an “Office set” and a “Home set”.

+ Keep a separate “Code snippets” set that you only use when you’re programming.

+ Organise your snippets into themed groups, e.g. “Names”, “Dates and times” or “Common phrases”.

« If you’re bilingual, you could maintain separate “English” and “Spanish” sets that you would enable as
and when you need to type in each language.

That last example is where sets can be especially useful beyond merely keeping things tidy and

organised by common themes. There may be cases in which you might want the same abbreviation to

expand to something different depending on which set(s) you’re using. For instance, you might have a
abbreviation that expands to when your “English snippets” set is active and to

when “Spanish snippets” is active.

In the Mac Finder snippet sets appear as files with the extension “.typeit4me”. Local “Sets on this Mac”
are stored in a Sets folder in Typelt4Me’s Application Support folder within your hidden user Library. If
you have a snippet set file somewhere else on your Mac (e.g. someone has emailed or Airdropped you
one to use), double-clicking it will automatically move it to the Sets folder and activate it.



Let’s take a look at how to create your own snippets set. It’s easy. All you have to do is open the main
Typelt4Me window - either using a hotkey or by selecting “Manage Snippets...” from the menu - then
click the + button below the bottom left corner of the ‘Sets on this Mac’ pane (pictured below).

When prompted, give your new set a meaningful name (“My Snippets”,
perhaps) and click the Done button or hit Enter / Return to save it.

@ Typelt4Me

Preferences Print Help Stats Register

Vv Selected set: Enter a name for your new set:
Sets on this M

_ My Snippet
2 Examples Y SniPp 4

Cancel



Once you've saved your newly created snippets set, you’ll see it appear in
the list, together with the bundled Examples set. You'll notice it’s
highlighted, which means it’s selected and the snippets it contains will be
displayed in the list below it. You'll also notice the checkbox next to the
set name is ticked; this means it is now an active set - that is, all snippets
added to this set will be expanded wherever you type the abbreviations
that represent them.

Remember, as of Typelt4Me 6.0 multiple sets can now be active
simultaneously. You can easily toggle them on and off as and when you
need them, by ticking or unticking the checkboxes next to the set names.
Again, you don’t have to use multiple sets if you don’t want to, it’s entirely
up to you. The option is simply there for anyone who prefers to keep
different snippet types in separate groups, for use in specific contexts.

...It probably hasn’t escaped your attention that there are two panes for
sets and that the one on the right is headed “Remote sets”. This is a
much requested feature previously only available in the Mac App Store
version for use with iCloud. Typelt4Me can make use of network
connectivity and cloud storage services to enable you to use the same
shippets on multiple Macs and keep them in sync. We’'ll explain this
further in section 2.6.2

L N

0 = O Ll

Preferences Print Help Stats Register

V Selected set: My Snippets (1 snippets)
Sets on this Mac: 2

Examples

v, My Snippets

+_

Snippets selected: 1 of 1
App Abbreviation Snippet

Al abb snippet



In Preferences you can enable iCloud Drive, Dropbox, Google Drive or a shared network folder in
which to store your snippet sets. Doing so enables you to use the same snippet(s) on multiple
Macs and keep those shippets in sync across all your machines even as you add new ones.
Enabling remote sets and specifying which sync service or shared network folder you’d like to use

is explained on page 90.

When you enable a cloud sync service or specify a shared network folder to use, it’s activated in
the pane to the right of “Sets on this Mac”. You can then create new sets in your remote folder
using the + button or move existing local sets to it by dragging them across (pictured below).

[ NON Typelt4Me

1 S Ol 2

Preferences Print Help Stats Register

Vv Selected set: My Snippets (28 snippets)

Sets on this Mac: 2 Sets in iCloud Drive: 0
Examples
¥ My Snippets My Snippets )

1. To move a snippet set from the local Sets on this Mac pane to your
preferred cloud sync or shared network folder, just drag it across.

[ NON | Typelt4Me

s 2@l S

Preferences Print Help Stats Register

V Selected set: My Snippets (28 snippets)

Sets on this Mac: 1 Sets in iCloud Drive: 1
Examples ¥ My Snippets

2. Your snippet set will now be shared with any other Macs you have
set up to use the same sync option in Typelt4Me.



2.6.3 How to get to a snippet set file in Finder

There may be times when you want to do something directly to your set file(s); perhaps you’ll
want to make duplicate backup copies to archive for safekeeping, or you might want to email or
AirDrop them to a colleague so s/he can use the same snippets. The folders in which snippet set
files are stored on your Mac are hidden by default, but there is an easy shortcut that will take you
straight to the file you want in the macOS Finder from within the Typelt4Me app. Just ctrl-click on
the name of a set in the list and then click on the “Reveal in Finder” context menu that pops up.

| NON Typelt4V

o =0 e

Preferences Print Help Stats Register

V Selected set: Examples (25 snippets)

Sets on this Mac: 1

Q E | 0@ | Sets
xamples =— — —
Reveal in Finder j m ol =y v O =v| W 2+ 3 Q Search

& iCloud Drive Name ~  Date Modified Size  Kind

F— @ AirDrop Examples.typeit4dme 11/08/2017 1.7 MB Typelt4Me Snippets
/A: Applications

=] Desktop

@ Documents

o Downloads

Snippets selected: 1 of 25

@) Pictures

ﬂ Music

1 of 1 selected, 66.34 GB available
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2.6.4 How to copy snippets from one set to another

Sometimes you may want to copy snippets between sets. You can do this quite easily. Just hold
the command (3€) key and select the snippets you want to move by clicking on them. Copy them
to the clipboard (36-C). Navigate to the other set you wish to add those snippets to. Then click

once anywhere in the list of snippets in the new set and paste (38-V).

V Selected set: Examples (25 snippet
Sets on this Mac: 3

Examples
My Snippets

+_

Snippets selected: 3 of 25
App Abbreviation Snippet

A br Best regards,
A |ds Dear Sir, =
A eml me@ettoresoftware.com 1
A |eso Ettore Software Limited S
B [hmedd [123 Home Steet, |
B [ [relotes |
A lor Lorem ipsum dolor sit amet
A | mynum 1-408-12345678910

F

1. Select the set that contains the snippets you wish to copy to
another set. 3-click on the ones you want until you've selected

them all, then press 3-C to copy them to the clipboard.

V Selected set: My Snippets (0 snipp
Sets on this Mac: 3

Examples

v My Snippets
+ o

Please select a snippet:
App Abbreviation Snippet

A hmadd 123a Home Street,
A ht Hello there,
A Ifwd I'm looking forward to it

2. Switch to the target set, then click once anywhere in the list of its
shippets and 38-V to paste the snippets you just copied from the
previous set into this one. They’ll be added to the bottom of the list,

S0 you may need to scroll down to see them
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Typelt4Me was the first text expansion program for the Mac, but these days it’s far from the only
app of its kind. If you have previously used similar software, then you may have already built up a
sizeable library of shorthand abbreviations. We don’t want you to have to re-create them all from
scratch, so as of version 6.0 you can now import your existing data in a couple of formats.

Import TextExpander snippets or CSV files:

You can pull TextExpander snippet files straight into Typelt4Me by dragging | NON )

and dropping them onto the “Sets on this Mac” pane. Plain text snippets will i = o |_
be converted automatically (minus any descriptive labels you had assigned to o
them). You will then just need to manually tweak date math and fill-ins to use

Preferences Print Help Stats

the equivalent Typelt4Me syntax (as explained later in this user guide) in v Selected set: Examples (25 snippets)
order for those special snippets to work. Sets on this Mac: 1
Examples

Not coming from TextExpander? If your old software supports it, save your

existing snippet file(s) in comma separated value (CSV) format, then drag and My snippets
drop your exported .csv file(s) onto the “Sets on this Mac” pane to import. +|—

Again, you may need to tweak some of your special date and time snippets to

use Typelt4Me syntax.



The humble Mac may be one of the greatest inventions since sliced bread, but things still can and
do go wrong, sometimes. A sudden hard drive failure or a careless click on a delete button can
result in an unexpected loss of data. We've all been there. Fortunately, the good people at Apple
gave us Time Machine, so we can back everything up to an external drive in case we need to
rescue lost data. If something happens to your Typelt4Me snippets but you regularly back up the
contents of your Mac, it will usually be possible to recover them. You can use Time Machine to
restore Typelt4Me sets like you would any other files.

Local "Sets on this Mac" snippet sets are stored in ‘~/Library/Application Support/Typelt4Me/Sets/'

Note that the files are stored in your *user* library, which is not normally visible in Finder as Apple
hides it by default. To restore a local Typelt4Me snippet set from Time Machine:

1. Plug in your Time Capsule or other external backup drive.
Click on Go in the Finder menu bar.

Hold down the alt key.

Click on Library when it appears in the menu.

Navigate to Application Support > Typelt4Me > Sets

o o A © N

Launch Time Machine

7. Navigate to the most recent backup of the Sets folder(s) you want and restore.



As of Typelt4Me 6.0, local incarnations of your iCloud Typelt4Me sets are stored within an
invisible ‘~/Library/Mobile Documents/Typelt4Me’ folder on your Mac, inside your hidden user
library. If you lose or accidentally delete an iCloud Drive-stored set, this is what you should do:

1. Plug in your Time Capsule or other external backup drive.

2. In Typelt4Me, ctrl-click on a set in “Sets in iCloud Drive” and select “Reveal” from the
popup menu. This will reveal the folder in Finder. (If there are no sets visible in iCloud
Drive, create a new temporary one just for this purpose).

3. Launch Time Machine.

4. Navigate to a recent backup of the iCloud Drive sets folder(s) and restore.



2.7 - Where and when does Typelt4Me type?

Technically, the “typing” that Typelt4Me performs when it expands one of your abbreviations is

usually a “paste” operation. It will occur wherever you are currently entering text, be it in a word
processing document, an email message, a save dialog, a folder or file name field, a database
entry field and so on.

A snippet - which can be text and / or picture(s) - will be pasted wherever the cursor is currently
positioned when you do one of the following things:

* you use your mouse or trackpad to “pick” it from a list in Typelt4Me's point-and-click menu

+ you type the abbreviation associated with the snippet (optionally) followed by any of up to 35
potential trigger characters. The default trigger is a space.

If you go to the Triggers tab in Typelt4Me’s preferences, you can define exactly what characters
should act as triggers. You can also choose to have no triggers, in which case your abbreviations
will expand as soon as you type them. To do that, just click the “None” button at bottom right.

When expanded, snippets that were defined and saved as plain text will match the font and style
of any text immediately preceding the point at which you insert them. “Only “rich text” snippets will
preserve the formatting with which they were originally saved, wherever you expand them.



Typelt4dMe works with the vast majority of third party applications that accept text input. That said,
while it’s rare, conflicts can occasionally arise and you may encounter compatibility issues once in
a while. The automatic “typing" of your snippets is achieved by temporarily placing the snippet
contents on the clipboard and issuing a Paste (3-V) command. Some apps are built in such a
way that they can’t handle pasting in certain text fields and this can prevent Typelt4Me from doing
its job. It’s also possible that third party apps and utilities for managing or extending the
functionality of the clipboard could interfere with Typelt4Me expansions.

If Typelt4Me ever appears to fail, try doing a "manual" paste (38-V) into the text field in which
you’re typing and see if that works. If it doesn't, then the developer of the software in question has
built it in such a way that it will prevent Typelt4Me from working. This is the case in Entourage, to
cite one example. You cannot expand an abbreviation in the save dialog that follows Save as PDF
in Entourage’s Print dialog. Meanwhile, the same operation works fine in Apple’s TextEdit and
Mail. If you run into a frustrating issue like this and consider it a deal-breaker, your best bet for
resolving it is to contact the developer of the software you’re using and request that they support
pasting into the field in question, so that it will play well with Typelt4Me.

Nowadays, password entry fields are typically protected against programs trying to "sniff" what
you type into them using a mechanism known as Secure Event Input. This temporarily prevents
Typelt4Me from working. For example, entering a Typelt4Me abbreviation directly in a password
field in Safari will not result in expansion of the snippet. All things considered, given today’s



increasingly risky digital security landscape, this is A Good Thing - we wouldn’t encourage you to
store sensitive passwords as unencrypted, plain text snippets.

It’s far more secure to use Safari’s keychain or a dedicated third party password manager app to
handle your online logins, as these can offer a sophisticated level of protection. However, if you
really want to - perhaps you have a low-risk ‘throwaway’ account you frequently log in to and
you’re not concerned about it potentially being compromised - you can use Typelt4Me to enter
passwords for you.

Entering passwords with Typelt4Me

Create an abbreviation, e.g. pw, and define the snippet as
using the Insert > Special menu
to insert the -1, carriage return and Don’t Append Trigger
symbols. On a login page in Safari, typing the abbreviation aop | Abbroviation | Snippet username-vpassword<i%-

and expansion trigger into the username field will submit your

login details for you.

Snippets selecteq:

From time to time - typically when filling in forms on web pages - you may see notifications from
Typelt4Me appear in the corner of your screen and / or in Notification Centre. These are to inform
you that an app you’re currently using (most likely a web browser) has enabled something called



Secure Input and that this will stop Typelt4Me from working. Secure Event Input is a powerful
protective feature built into macOS that many apps and websites use to shield your passwords

and recorded for nefarious purposes and only you will know what you're typing. Secure Event
Input is very much a good thing and it's a crucial defence against data theft, however
. It can cause problems if it isn't turned off again once it's done its job.

For as long as it’s enabled, Secure Input will prevent Typelt4dMe from working

In some apps, when the Secure Event Input protection is triggered it can erroneously remain
enabled even after you're done entering the sensitive information and / or you switch to a different
app. Typelt4dMe and other text expansion apps will then be 'locked out' of keyboard input, unable
to see what you’re typing and prevented from functioning until Secure Event Input is turned off.

It’s important to note, though, that when a Typelt4Me notification appears and alerts you that an
app has enabled Secure Input, that doesn’t necessarily mean that expansion will no longer work
until the app in question is closed. Rather, its purpose is to make you aware of the last app(s) that
recently switched Secure Input on, in case you then find text expansion no longer works and you
need to identify which app may have left Secure Input enabled for too long.

How to resolve the Secure Input issue and get Typelt4dMe working again

If Secure Input stops Typelt4Me from working you'll need to identify the app that has left Secure
Input enabled and quit that app. Doing so will enable Typelt4Me to resume expanding your
abbreviations as normal again. If you can’t remember what the last alert or banner said, check
your Notification Centre to see if there are any Typelt4Me messages in there to help track down
the app that’s responsible.

_ Secure Input Enabled

and other sensitive data while these are being entered. This is so that they can't be intercepted 2.)

Safari has enabled Secure Input. This prevents
Typelt4Me from expanding abbreviations.


http://developer.apple.com/library/mac/#technotes/tn2150/_index.html
http://developer.apple.com/library/mac/#technotes/tn2150/_index.html

It's often a web browser such as Google Chrome or Firefox that leaves Secure Input enabled,
though there are known issues with other software too, including VPN apps, antivirus clients and
popular password managers such as 1Password or Lastpass. If none of those looks to be
responsible, it could also be down to other third party apps like Fluid, Hulu Desktop, iFinance,
Quicken Scheduler, Chronories or Notational Velocity. If you're a command-line tinkerer you might
also want to ensure that Terminal's 'Secure Keyboard Entry' is turned off when you're done
entering a password.

How to stop Secure Input warnings

Secure Event Input is a core functionality built in to macOS and can’t be ® < i Notifications

Completely disabled or bypassed' If an app WantS to tUl'n It 0n7 there,s no No_tification Centerl showsxour_alerts in the uppe(-rig'ht _of yqur screen, without interrupting what you're
Stopping It, Type|t4Me haS no ContrOI over that But |f nOtificationS become SO doing. Show and hide Notification Center by clicking its icon in the menu bar.

frequent and / or irritating that you’d rather not see them, it’s easy to stop them Ag] Twitter TSNS slectstie:

from appearing. Open your Mac’s System Preferences and go to Notifications

(it’s in the top right corner). Once you’re in Notifications you’ll see a list of apps

on the left. Select Typelt4Me in the list, then select the “None” option and untick [ S Ao

the checkboxes under “Typelt4Me alert style”. oSl Alats Sy o Sornen w Shraea”

Show notifications on lock screen
Show in Notification Center: = 5 Recent Iltems d
Badge app icon

Turning off all notifications is not something we recommend, however, as they Play sound for notifications
can provide invaluable clues to what’s happened should Typelt4Me expansion
stop working all of a sudden. If you just want to make notifications less intrusive
so they don’t distract you, we suggest that you leave the “Show in Notification
Centre” box checked, while turning off alerts and sounds.

Notification Center sort order: = Recents ﬂ ?




2.8 - How do | stop Typelt4dMe from typing stuff for me?

Sometimes you may want to stop Typelt4Me from doing its thing, for one reason or another.
Of course, you could quit Typelt4Me altogether, but you may find it more convenient to leave it
running and just selectively stop it expanding abbreviations. There are a few ways to do this.

The default trigger for expanding an abbreviation is typing a space after it. If ever you want to type
an abbreviation as part of a sentence without Typelt4Me expanding it, all you need to remember
is to hold down the shift key as you type the space after it. Doing so will prevent expansion.

cl= o % L Tue343pm Q = H i
RESRIN  Avout Typetavi If you want to type continuously for a few minutes
s, without any interference by Typelt4Me, you can
Add a Snippet... ‘ temporarily pause automatic expansion of typed

Manage Snippets...

abbreviations. To do this, select the Pause option
in the Typelt4Me menu. A small " symbol on the
Typelt4Me icon in the menu bar will denote that
the app is in pause mode.

Preferences...

[ Quit



P1= o % &L Tue3ds5pm Q =
8 a0 r When you're ready for Typelt4Me to carry on
expanding your abbreviations as normal, just

Check for updates
Add a Snippet...
»; Manage Snippets... select the Resume option.
iJ Preferences... | ;
4 Resume

‘ Quit

If you're after a longer term solution that switches typing expansion off

indefinitely - even across system restarts - you may wish to check the o fpe
“Disable keyboard expansion” box in Typelt4Me’s Preferences. To find -
this, click on Preferences and navigate to the Expansion tab. It’s the first Preferences Print Help Stats

option in the list on the left.

General  Triggers [=dechiionl | Auto

Expansion preferences:

While this box is checked in Preferences, nothing you type will ever
be expanded. However, you'll still be able to use the point-and-click Disable keyboard expansion
menu list to insert snippets, should you need them.

Don't append triaaer



There may be certain apps in which you never want expansion to

occur. To that end, you can selectively disable Typelt4Me on a
per-app basis.

All you need to do is go to Typelt4dMe’s Preferences, navigate to
the Special tab and add those apps you’d like to exclude from
expansion to the list of apps that require special behaviour. Just
click the + button at bottom left and select an app to add to the
list. You'll see that the default special behaviour is to not expand
shippets, so you can leave that as it is.

Once you’ve added the app(s) you'd like to exclude just click
Done and from that point on, Typelt4Me won’t expand any of
your snippets when you’re working in that particular application.

If you later change your mind, just return to the Special tab in
Preferences, click the app in the list to select it, then use the -
button at bottom left to remove it.

TypeltdMe

Preferences Print Help Stats

General  Triggers Expansion  AutoCorrect Lldell) HotKeys  Sync

By default, all abbreviations in all active snippet sets will expand in all apps. Here you
can specify different behaviours that will be unique to specific apps. For example,
you can specify that abbreviations should not expand in iTunes. Or, you can specify
that you only want snippets from one specific set to expand when using Pages. Just
drag or add an app into this list to instruct Typelt4Me to make a special exception
and behave differently in that app. Click and hold the arrows for a pop-up menu in
which you can specify ‘Do not expand’ or ‘Expand using...’ and pick a specific
snippet set to use with the app.

Application Special Behaviour
@® 1Password 6.app £ do not expand
() iTunes.app £ do not expand
& Safari.app £ do not expand
+
Done

Version 6.0 (125)




2.9 - How to include pictures, styling and hyperlinked text in snippets

It’s likely you’ll mainly be using Typelt4Me to expand abbreviations to long words and phrases,
but in addition to text, snippets can include pictures. You might, for example, create an email
sign-off snippet that contains a scanned picture of your signature. Or, you could create a
snippet that inserts a drawing when you type the abbreviation that represents it.

Abbreviation: Label:

owlpic Drawing of an owl

} Plain text
EhlfJ AL ChIE o Rich text/pictures ;

To include a picture in your
snippet, you first need to click the
“Snippet contents” pulldown menu
and change the content type from
“Plain text” to “Rich text/

pictures” (as shown in the
screenshot to the left).

Once you’ve done that, place the cursor in the main snippet editing box. You can then either drag
& drop or copy and paste pictures into the snippet. Most common formats will work (gif, jpeg, png,
tiff, et al.) but do keep an eye on the file size of your images. If you accumulate an extensive
shippet library containing lots of very large, high resolution images, this can slow Typelt4Me down.

Abbreviation: Label:
owlpic Drawing of an owl
Snippet contents: = Rich text/pictures @

Insert @ Format E

opet(s): Default a Save

Version 6.0 (125)




2.9.2 Apply formatting to the text of a snippet

When “Rich text/pictures” is selected from the
“Snippet contents” pulldown menu, you can apply
formatting to any of the text in your snippet. Font,
colour, bolding, italics, underline and other
attributes can all be adjusted to your heart’s
content. To change any of these you can either
use standard keyboard shortcuts or pick from the
Format menu, as pictured here.

Typelt4Me offers considerable flexibility when it
comes to formatting your snippets. Have a play
around with the various options and try mixing and
matching different styles.

Abbreviation: Label:

One caveat to note: not all apps in which you type will honour the rich text formatting
you've applied to your snippets. You will likely encounter a few that take it upon
themselves to strip out some or even all attributes, or that force the expanded text to

match the formatting of immediately preceding content.

frmt Formatted snippet
ling
Snippet contents: | Rich text/pictures
Look at the fancy styling you can apply to
this text! it's wonderfully liberating,
if you’re into that kind of thing.
Insert v Format > Font | 2 | Show Fonts &BT
L Text | 2 Bold B
ppet(s): Default Save P v ltalic 8l
Underline $U
Version 6.0 (125) Bigger 38,
Smaller 8-
T —— cern >
Ligature | 2
Baseline | 2
Show Colors  {*3C
Copy Style \&C
Paste Style &8V
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Sometimes, you may want to include some hyperlinked text in the body of a snippet that will open
a web page when clicked. Perhaps you’d like your email signature snippet to contain a link that
goes to your website, for example. While you can’t create an active hyperlink from scratch within
the app itself, Typelt4Me does support hyperlinks in snippets.

To include a hyperlink:
1. Select and copy some hyperlinked text from an email or web
page to your clipboard.

2. Create a new snippet and select “Rich/text pictures” from
the snippet contents pulldown menu.

3. Past h linked text into th . t editing b Abbreviation: Label:
. r rlin n n n . .
aste your hyperlinked text into the s |ppe. e ||.g 0X, hol Website hyperlink
add any further text or other content you wish to include, .
styling
then save.

Snippet contents: = Rich text/pictures

Visit our website:
That’s all there is to it. Now when you type the abbreviation in %O@FGI
apps that accept rich text and / or hyperlinks, the hyperlinked part

. . . . http: ett ft :
of the snippet will remain clickable when it’s expanded. p:/[www.ettoresoftware.com/



2.10 - How to limit an abbreviation to a specific app

In certain circumstances you may wish to specify that an abbreviation should only expand
when typed in one specific app. To do this, just click the icon in the “App” column to the left of
the abbreviation; this will open a menu in which you can select the app to which you’d like to

confine the abbreviation.

Say for instance we want the abbreviation ds to expand to but only ever in the Apple
Mail app and nowhere else. In order to specify that, just do the following:

1. Click the app
icon to the left of

the ds abbreviation = D)



2. Double click on the
Mail app in the popup
dialogue to associate it
with the abbreviation

@ @ Typelt4Me

=Yy

Preferences Print Help Stats Register

B J< 288 é@ &=v  [m Applications

<>

& Font Book.app

Favorites
g S &% Game Center.app
FORDOX & GarageBand.app
& iCloud Drive Q) iBooks.app
A Applications @ Image Capture.app
¥ iMovie.app
= Desktop (&) iTunes.app

M Documents ' Keynote.app
@ Launchpad.app

L 9 Downloads &l Mail.app

(| Q Search

12} user =% Maps.app Mail.app
. . ¢ Messages.app
€8 Pictures B3 Mission Control.app
’ ’ Application - 42 MB
73 Music W Notes.app Created 29 August 2015 at 03:52
] Movies sl Numbers.app Modified 27 October 2015 at 16:36
. */ Pages.app Last opened 27 October 2015 at 19:36
3 Google Drive 8% Photo Booth.app Version 9.1
Tooe g Photos.app Add Tags...
=2 Preview.app
Cancel Open
l =V Q_ Filter abb/snippet | " Insert 2] Format <

Preferred menu display style of the selected snippet(s): Default

<>

wn

Q
D

Version 6.0 (125)
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Once you’ve done that, you’ll notice the previously generic app icon (that denotes an
abbreviation will expand in all apps) has been replaced with the Apple Mail icon. This
means the abbreviation will now only expand when typed in that particular app.

br
ds

T

To clear an association, just click once on the
app icon to the left of an abbreviation and
confirm your choice when prompted.

Best regards

Dear Sir,

(

Typelt4Me

This abbreviation is associated with 'Mail' and will only
expand in that application.
Do you wish to clear the association?

Cancel Clear
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2.11 - Labelling snippets

Snippets can optionally be assigned labels to help you identify them in the
Typelt4Me menu. If you only ever use typed-at-the-keyboard expansion you
may not want to bother with it, but it can be a useful feature if you do find pbreviation: Sg- 1
L. . h2 Work iPhone number
yourself manually picking snippets from the menu.

et contents:  Plain text T

For example, you might have two phone numbers: one for personal calls For each snippet, type a memorable descriptor in the Label

and the other for office-related matters. Instead of showing up in the menu
as two confusingly similar multi-digit numbers, they could appear as clearly
distinguishable work and personal numbers.

field to help distinguish it from others that may be similar.

=

= 4

A Tue716pm Q= b1 = A Tue719pm Q=

About Typelt4Me About Typelt4Me
Help Help
Check for updates Check for updates
Add a Snippet... Add a Snippet...
Manage Snippets... Manage Snippets...
Preferences... Preferences...
Pause Pause
Quit Quit
Pr- s e . 3 Accented Words o : A A o Accented Words
Two similar numbers : : Iy Symbols e Two clearly labelled : : i g Symbols
¥ n & Words & Phrases 3 i e Words & Phrases
with no labels... 55 1-408-45678910123 Phone numbers oy number snlppets RS- Personal iPhone number Phone numbers

1-408-12345678910

Work iPhone number 1-408:12345678010 Iy
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2.12 - Displaying snippets in the Typelt4Me menu

L Tue751pm Q =
About Typelt4Me
Help

Check for updates

Let’s take a look at the point-and-click menu Typelt4Me offers as an

alternative to expanding abbreviations as they’re typed. By default, this

lists all the snippets in the currently active sets, showing the

abbreviations alongside the labels if you have labelled them, or all or

part of the snippet content if you haven’t. You can change this and

R — Examples assign different behaviours to individual snippets. It’s possible to display

EICTCJEEEVSVQMS ‘ none, some or all of your abbreviations in the menu, setting each one to
show just the snippet, just the label, both or nothing at all.

Add a Snippet...
Manage Snippets...

Preferences...

Pause
Quit

Greeting (M)

Work email address

Popular Brands, Products & Tech
Symbols
Words & Phrases

¢ Company name

2 Home address
Hello there,
| I'm looking forward to it
Latin placeholder text

My work phone number

Open Mail with Zarvox voice

To change the way a snippet is displayed in the Typelt4Me menu, bring
X:gmﬂhm::mkﬁ;s;T:.wniﬁe,:fﬁi%‘Ie i up the main app window and click on it once in the list of snippets to
. r“ltkt’hyﬂ“1‘1“&"9;‘”“(";;{"3” : select it, then pick the option you want from the ‘Preferred menu display
Typetiave e T style’ pulldown at the bottom.

" Request tweaks to report

Submit feedback by 3 months from today

that's amazing!

~ lor Lorem ipsum dolor sit ame
(@ [mynum  [1-408-12345678910
. . =l — =v I t
Use the display style pulldown to specify how you I=v( a et &
want your Snippet to be displayed in the menu. Preferred menu display style of the selected snippet(s): = Show label [T

Version
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ITwa I'm lookKing torwara to It

A | lor Lorem ipsum dolor sit ame
— : Hide 881
I—I— | —| IE Vl | Q Filter abb/snippet Show snippet YY) Forr
Show label 83
Preferred menu display style of the selected snippet(: ow bo 384

Version 6.0

Selecting a snippet, giving it a “My work number” label
and picking the ‘Show both’ option from this pulldown...

...will give you this result in’
point-and-click menu -

Please note: the default display style is different
from that of previous versions. In Typelt4Me 5.5.x
and earlier, the default was to display only the
abbreviation in the menu.

eml

Popular Brands, Products & Tech »>
Symbols >
Words & Phrases »

Company name eso

Home address

Hello there,

I'm looking forward to it

Latin placeholder text

My work number — 1-408-12345678910

Open Mail with Zarvox voice

Request tweaks to report

Submit feedback by 3 months from today

save time

Typelt4Me t4m
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2.13 - Sorting and searching abbreviations and snippets

Over time, you may build a substantial library of shorthand abbreviations. It’s not uncommon for
Typelt4Me sets to contain hundreds or even thousands of snippets. This could grow problematic
to manage if it weren't for...the humble sort button and its stalwart partner the search filter. These
two controls can be invaluable for taming large snippet libraries. Between them, they can help you
to zero in and find specific snippets you may be looking to edit or remove.

Sort button Search filter
Snippets can be sorted using any of the following criteria:

Abbreviation (alphabetical or reverse alphabetical order)

Snippet (alphabetical or reverse alphabetical order)

NV +- Il 2
Custom (drag individual snippets into your preferred order) =
v Sort by abbreviation
Preferred Sort by snippet |
Sort by custom
Sort by date created
Sort by date modified
Date last used (most recently expanded abbreviations at the top) SR e e
Sort by use frequency
Sort by label

Date created (newest at the top)

Date modified (most recently modified at the top)

Use frequency (most frequently used snippets at the top)

Label (alphabetical order)



When you select “Sort by abbreviation” or “Sort by snippet”, the relevant column header will
display an upward arrow ( * ) indicating the alphabetical sort order, with symbols at the top,
followed by numbers and finally the letters A through Z. To reverse the sort order, click once on
the column header. The upward arrow will change to a downward arrow to reflect the order.

ohippets selecteaq: |
App Abbreviation A Snippet
N br Best regards,
ds Dear Sir,

Looking for a specific snippet? When the snippets list is alphabetically sorted by snippet, typing a
few letters will scroll the list to the first snippet that starts with those letters. When sorted by any
other criteria, the list will scroll to reveal the first abbreviation that starts with the letters you type.



Type one or more letters into the filter field and the list of snippets will shrink to show only snippets
that contain the combination of letters you typed - anywhere in the abbreviation or the snippet
contents. As shown here, with the bundled Examples set active typing the letters into the filter
narrows the list down to three snippet results. The first and last results in the list contain the letters
in their abbreviations (eml and thxem), while the middle result - a latin dummy copy snippet -
appears because in the contents of the snippet the letters are found in the latin word Lor

Please select a snippet:

App Abbreviation Snippet
A |br Best regards,
A | ds Dear Sir, Please select a snippet:
A eml me@ettoresoftware.com App Abbreviation Snippet
A €SO0 Ettore Software Limited A eml me@ettoresoftware.com
A hmadd 123a Home Street, A | lor Lorem ipsum dolor sit a...
A | ht Hello there, A thxem Thank you very much f...
A Ifwd I'm looking forward to it A |tsh When this happens, we...
A lor Lorem ipsum dolor sit a...
A mynum 1-408-12345678910
e =v Q
Preferred menu display style of the selected snippet(s
ar =v| |aem (%)
00 Preferred menu display style of the selected snippet(:




2.13.4 Search and insert snippets using the floating search window

As of Typelt4Me 6.0 you can assign a “Search snippets” keyboard shortcut in Preferences >
HotKeys to summon up a snippet search window that floats over whichever app you’re using. Typing
in Mail and can’t remember the abbreviation you defined for your work address? Just hit the search
hotkey and type part of your address into the floating search field that appears (or perhaps the word
“work” if that’s what you labelled the snippet). Use the arrow keys to move through the list of results
and hit the return key to insert the snippet you want. To dismiss the search window without
expanding anything, just press the hotkey again. It works as a toggle.

@ [ ) Search Typelt4Me snippets

Q_ work (%)
Abb Label Snippet

emi| Work email me@ettoresoftware.com

mynum My work phone 1-408-12345678910
wkadd Work address 2345 Office Lane,

work Work NB: this search feature is only available when you have

Typelt4Me set to “not* show in the Dock. If you have set
Typelt4dMe to be displayed in your Dock but you want to
ﬁg‘:ﬁismﬁz hinze’ be able to use the snippet search window, first you need
United Kingdom to go to Preferences > General and in the “Icon display”
section select “Show Typelt4Me in: Menu bar” (click the

middle radio button). Then go to Preferences > HotKeys
and you’ll be able to assign a “Search snippets” key to
bring up the search window.
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2.14 - “What does the Insert menu do?”

The Insert menu directly below the main snippet editing field enables you to craft more sophisticated
snippets. These might produce fill-in-the-blanks placeholder ‘prompts’ when expanded or perhaps
use arithmetical formulae to expand to dynamically generated, context-aware snippets. You can do
things like automatically insert a date that’s two weeks from now without having to work out what it
will be. You can also embed special characters, nest snippets or even execute complex Applescripts
when you type an abbreviation.

Let’s look at how you might go about creating a snippet
that expands to the current date. First, bring up the main

. . Snippets selected: 1 of 2 Abbreviation: Label:
app window and click on the + ("add") button underneath — —— —— BN
the list of snippets. A fresh / entry will appear 8 [kr Kind regards
at the bottom of the list and the focus will move to the A abb snippet Snippet contents:  Plain text
Abbreviation field. The placeholder text can now be Sninipat

typed over and replaced with a memorable text shortcut.
How about dil or something similar for now? You can
come back and change this later if you like.



Type in the new abbreviation. For this example, dil will stand for date in long format.

We’re going to make that expand to the current date, e.g.

Once you've typed dil in the Abbreviation field, press the
-1 (tab) key to progress to the Label field. You can leave
this blank if you like. For our example, though, we’re
going to give the snippet a label. This is just to make it
clearer exactly what the snippet produces in case we
forget later. Let’s label it as
shown, to reflect what the output will look like. If you'd
prefer something different, that’s fine; what’s important is
that it should make sense to you.

When you’re ready, press the = key again to progress to
the main snippet editing field. The placeholder
text will be selected, ready to be replaced with the
content of our date snippet. Normally, you’d type or paste
some ordinary text content over it, but here we’re creating
a snippet that will automatically produce the current date.
We need to put in a kind of formula that Typelt4Me can
interpret. That’s where the Insert menu comes into play.

Snippets selected: 1 of 2

App Abbreviation ~ Snippet

A

AN

kr
abb

Kind regards
snippet

Snippets selected: 1 of 2

App Abbreviation ~ Snippet

A

oy

kr
abb

Kind regards
snippet

Abbreviation:

dtl

Snippet contents:

snippet

Abbreviation:
dtl

Snippet contents:

snippet

Label:
Day, Month DD, YYYY

Plain text

Label:
Day, Month DD, YYYY

Plain text



Click on the Insert menu, then roll over the Date
submenu that pops up to reveal a list of options.
You'll see there are a number of pre-cooked date
format templates you can choose from. If you
hover over them, each of these will reveal a
tooltip showing the corresponding syntax* that
produces it. This typically looks like a string of %
symbols mixed with letters, numbers and
punctuation. Clicking one of the options in the list
will insert the required syntax into your snippet.

Later, when you grow more confident you may
decide to use the Date and Time menus to roll
your own custom snippets, mixing and matching
the individual elements that are separated out in
the lower three sections of the menu. You can get
very granular and even choose whether to display
a leading zero in the month and / or day. For now,
though, let’s stick to creating our basic Day,
Month DD, YYYY snippet; it just so happens to
match one of the provided off-the-shelf templates.

*It's actually a standard way to describe the elements
making up date and time, called strftime. But as Leslie
Nielsen’s beloved airborne physician would say, that’s

not important right now.

bbreviation: Label:

Day, Month DD, YYYY

dtl

Snippet contents: = Plain text

snippet

s): Default

v Insert

Time -

Date / Time Math...
Special

Snippets

14/10/17

Saturday, October 14, 2017
Sat, Oct 14, 2017
20171014

2017-10-14

October 14, 2017

Oct 14, 2017

171014

17-10-14

2017
17

October
Oct

10

10

Saturday
Sat

14

14

%A, %B %e, %Y



The long format current date we’re creating for this example corresponds to the second option in
the list of templates, so click on that one. Instead of the placeholder, the main snippet
editing pane should now contain the following: (as pictured below). Save the
snippet - with a 3-S, or with the Save button, or by clicking anywhere in the list of snippets - and
you’re done! Try typing dil in a text editor or Mail message and watch the date magically appear.

Snippets selected: 1 of 2 Abbreviation: Label:
App Abbreviation ~ Snippet dtl Day, Month DD, YYYY
A kr Kind regards

m %A, %B %e, %Y Snippet contents:  Plain text w

%A, %B %e, %Y

That’s pretty much all there is to it. No more scratching your head trying to remember what day it
is, fumbling for a calendar or painstakingly typing out the current date. Just rattle off a quick dil (or
other abbreviation of your choice) and Typelt4Me will take care of the rest, spitting out

(for example) in the blink of an eye.



To insert the current time, we follow the same initial steps
outlined in section 2.14.1 that covers inserting the current
date. First, in the main app window click on the + ("add")
button underneath the list of snippets. A fresh /

entry will appear at the bottom of the list and the
focus will move to the Abbreviation field. The
placeholder text can now be typed over and replaced with
a memorable text shortcut. How about or something
similar for now? You can always change it later.

Type in the new abbreviation. For this example,

Snippets selected: 1 of 3

App Abbreviation ~ Snippet

N

A

N

We’'re going to make that expand to the current time in 24h format, e.g.

Once you've typed in the Abbreviation field, press the
-1 (tab) key to progress to the Label field. You can leave
this blank if you like. For our example, though, we’re
going to give the snippet a label. This is just to make it
clearer exactly what the snippet produces in case we
forget later. Let’s label it as
shown, to describe what the output will look like. If you’d
prefer something different, that’s fine; what’s important is
that it should make sense to you.

kr
dtl
abb

will stand for current time.

Kind regards
%A, %B %e, %Y
snippet

Snippets selected: 1 of 3

App Abbreviation ~ Snippet

N

A

N

kr
dtl

abb

Kind regards
%A, %B %e, %Y
snippet

Abbreviation:
abb

Snippet contents:

snippet

Abbreviation:
ctm

Snippet contents:

snippet

Label:

Plain text

Label:
Current time (24h clock)

Plain text

B



When you're ready, press the =1 key again to progress to the main
snippet editing field. The placeholder text will be selected,
ready to be replaced with the content of our time snippet. Normally,
you’d type or paste some ordinary text content over it, but here we’re
creating a snippet that will automatically produce the current time.
We need to put in a kind of formula that Typelt4Me can interpret to
produce the desired time stamp. That’s where the Insert menu
comes into play.

Click on the Insert menu, then roll over the Time submenu that pops
up to reveal a list of options. You'll see there are some pre-cooked
time format templates you can choose from. If you hover over them,
each of these will reveal a tooltip showing the corresponding syntax*
that produces it. This typically looks like a string of % symbols mixed
with letters, numbers and punctuation. Clicking one of the options in
the list will insert the required syntax into your snippet.

You can mix and matching the individual hour, minute and second
elements that are separated out in the lower four sections of the
menu. Choose whether to output in 12 or 24h format, whether to
display an AM/PM suffix and even whether to display a leading zero
for the hour. For now, let’s stick to creating our 24h time snippet; it
just so happens to match one of the off-the-shelf templates.

Abbreviation: Label:

ctm Current time (24h clock)

Snippet contents:  Plain text E

snippet

v Insert > Date > |
Time »
(s): Default E Date / Time Math...

Special | 2
Snippets

*The syntax is actually a standard way to describe the
elements making up date and time, called strftime. We
recommend reading up on it on Wikipedia if you ever
have trouble sleeping.

17:24 %H:%M
17:24:54

17
05
17
5

24
24

54
54

PM



The 24h (XX:XX) timestamp we’re creating for this example corresponds to the first option in the

list of templates, so click on that one. Instead of the

placeholder, the main snippet editing

pane should now contain the following: (as pictured below). Save the snippet - with a
#-S, or with the Save button, or by clicking anywhere in the list of snippets - and you’re done!
Try typing in a text editor or Mail message and watch a timestamp magically appear.
Snippets selected: 1 of 3 Abbreviation: Label:
App Abbreviation ~ Snippet ctm Current time (24h clock)
A kr Kind regards
A dtl %A, %B %e, %Y Snippet contents: = Plain text [T

B Lo o [

That’s pretty much all there is to it. Just rattle off a quick
and Typelt4Me will take care of the rest, spitting out

(or other abbreviation of your choice)

(for example) in the blink of an eye.

...What'’s that, you say? You want to be able to do more than just insert today’s date and the
current time? Aha. We thought you might. Read on to learn how to craft some more advanced
date and time snippets that will automatically produce dates and times at specific points in the

past or in the future.



In addition to inserting the current date and time, Typelt4Me offers
date and time mathematics. You can set up formulae that will

calculate a past or future date for you in relation to the present and
produce that dynamically upon expansion. For example, you might

wish to create a ‘due date’ abbreviation that expands to Abbreviation:  Label:
sfdd Submit by [+3 months]
Snippet contents: = Plain text E

Please submit your feedback by

To create that snippet asking people to submit feedback by a due
date exactly 3 months away, start off the usual way, defining a plain
text abbreviation ( perhaps) that will expand to the phrase

(include a space at the end).
L

v Insert » Date » 17/10/17
T Time [ Tuesday, October 17, 2017 R RRIRAS
(s): Default a Date / Time Math... Tue, Oct 17, 2017
20171017
) . Special P 2017-10-17
All good so far? Great. We're halfway there already. Next, with the — L | October 17,2017
cursor still placed at the end of that phrase, click the Insert menu — ?;1‘01177 Akl
and pick a Date format. For this example, let’s go with the second 17-10-17
option from the top. It includes the named day and month in the 2017

. . . . 17
output, so it will be all the more impressive when you later see
October

Typelt4Me work its arithmetical magic and automatically type Oct
exactly the right day three months in the future without the need 10

10
for you to calculate it in your head or consult a calendar. s
uesday

Tue
17
17



Your snippet should now look something like this:
The string of percentage signs and letters tells Typelt4Me what date format to use when it calculates
and outputs the date during expansion.

Next, it’s time to concoct a formula. In the Insert menu, pick the Date / Time
Math... option. A window will appear that shows the current date and time.
Underneath that, there will be a number of ‘stepper’ buttons that correspond

Abbreviation: Label: )

S T E—"— to days (DD), months (MM), years (YY), hours (HH) and minutes (MM).
These are for specifying how far in the past or future the dynamically

Snippet contents:  Plain text E generated date should be.

Please submit your feedback by %A, %B %e, %Y{

Click on the upward arrow part of the

MM stepper button three times to add 1 Use the steppers to increase (or decrease) the value
to add to (or subtract from) each time component at

three .months t.o the c.urrent date (the expansion time.

resulting date in relation to the

nsert > IR > present will be displayed above, on 17/10/ 2017, 21:54 >>>  17/01/ 2018, 22:00

Time | 2 . , . ‘

e B the right). When you’re done, click oAM=k ol SR ol

, OK. This will insert a formula in your : . : : .
Special | 2 . . DD MM YY HH MM
snippet that will output a date exactly Remove Date Math
Snippet b . .
L three months in the future every time

the snippet is expanded. Click the Cancel [ oK ]
Save button and you’re done.



With the date and time mathematical formula added, your snippet will look something like this:

Snippets selected: 1 of 4 Abbreviation: Label:
App Abbreviation v Snippet sfdd Submit by [+3 months]
m Please submit your fee... -
A kr Kind regards Snippet contents:  Plain text [T
A dtl %A, %B %e, %Y Please submit your feedback by %A, %B %e,
x| Ctm %H:%M %Y @@@7952400.000000
In this example, now every time you type the abbreviation Typelt4Me will expand it to

, dynamically calculating the last part
upon expansion to produce a date exactly 3 months hence. So if today is Tuesday, October 17,
2017, typing will produce

Now you know how it’s done, you may wish to practice repeating the process and use more of the
stepper buttons to construct more complex formulae and create abbreviations that will expand to
various different dates and times of your choosing.



When defining your snippets you can use the Insert > Special menu (pictured) to embed certain
special characters in expanded text. The following can be inserted:

+ aspecial syntax (%l ) to tell Typelt4Me where to position the
cursor after expansion. For example: an abbreviation
could be defined as and would expand
to with the cursor placed between the
HTML tags, ready for you to type the text to be marked up as

bold in a web page you are editing. o »
—l Time =

@ Date / Time Math...
+ aspecial symbol (<X]) to represent a backspace (e.g. if you BETZEE Fosition cursor here
define g to type you'll be able to stick the ending to !
. . Snippets | 2 <] (Type a Backspace)
any previously typed verb, saving you a keystroke) . —~ (Type a TAB)
1+ (Type a TAB left)
<J (Type a Carriage Return)
+ aspecial symbol (-) to represent a tab that will be typed % (Paste Clipboard Here)
separately from the rest of the snippet (very useful to create _
snippets that fill two or more tab-separated fields or cells) . g T Lol
#autocue ;
) ) Append Trigger
- aspecial symbol (<J)) to represent a Carriage Return (also Don't Append Trigger

called Enter) that will be typed separately from the rest of the
snippet. This can be very useful to "press" the Send, OK or
Login button when filling in forms.



a special symbol (38) to tell Typelt4Me to insert the current text content of the clipboard at
that position (NB: if you ever need to have the 3 symbol actually appear in the expanded
text, insert two of them next to each other when defining the snippet, like so: 3 36).

a special symbol (%) which will cause Typelt4Me to send the entire text of the snippet to
AppleScript for execution. (Note: if the text is not a valid AppleScript script, expanding the
abbreviation will return an error. It is up to you to ensure the AppleScript is valid, as
TypeltdMe performs no checks.)

a special syntax (%+) to tell Typelt4Me that it *must* append the trigger that caused the
abbreviation to expand. This is useful for overriding the general Preferences setting for the
Append/Don't Append Trigger option on an snippet by snippet basis. For example, if you
use a space as a trigger and you’ve set your general expansion preferences not to keep
the space at the end once snippets have been expanded, you can make an exception for
an individual snippet by inserting %+ at the end when you define that snippet.

a special syntax (%-) to tell Typelt4dMe *not* to append the trigger that caused the
abbreviation to expand. Again, this is handy if you want to override the general
Preferences. For example, if you use a space as a trigger and have stuck with the default
Typelt4Me behaviour of keeping the space at the end once snippets have been expanded,
you can make an exception for an individual snippet by inserting %- at the end when you
define that snippet. Doing so will discard the space once you’ve expanded that particular
snippet.



+ aspecial syntax (&cautocue :) to tell Typelt4Me to display the text between the scissors

and hourglass as a cue and then wait until you press - to continue. We'll explain autocue

in more detail in the next section.

Autocue is a great time-saving feature that’s popular with power users. It enables you to set
up templates containing placeholder prompts ("cues") for you to replace with corresponding

text or data when a particular abbreviation is expanded.

Date | 2
Time | 2
Date / Time Math...
}
Position cursor here
Snippets | 2 l <&l (Type a Backspace)

=1 (Type a TAB)

- (Type a TAB left)
<J (Type a Carriage Return)

3 (Paste Clipboard Here)

% (Execute as AppleScript)

$<autocue *

Append Trigger
Don't Append Trigger

To include an autocue when defining a snippet, position the cursor
in the snippet content editing pane where you want it to start, then
use the Insert > Special menu to insert an autocue. It will initially

appear like this: &<autocue : . Replace the “autocue” placeholder

text that appears in between the scissors and hourglass with
whatever word(s) you would like the temporary prompt to display
when you later trigger it.

NB: once you've triggered an autocue snippet and typed over the
prompt you must press = (the tab key) to complete the expansion.
Additionally, for autocue to work the snippet must be a plain text snippet.
Rich text formatted autocue snippets are not supported just yet.



Let’s look at a hypothetical example of how a doctor writing a letter might use autocue for
quickly entering a patient’s details in a standard format. S/he could have defined an
abbreviation, e.g. , that expands to a snippet spread over several lines, with autocues
inserted to prompt for the patient’s name, date of birth, height and so on.

Snippets selected: 1 of 1 Abbreviation: Label:
App Abbreviation ~ Snippet pdet Patient details

m Patient details:

)

Snippet contents:  Plain text
Patient details:

Name: &name :

Date of Birth: $<dd : /&€mm : [eRyyyy ;
Height: 8&<height (cm) : cm

Weight: &<weight (kg) = kg

The abbreviation will expand in stages, with each autocue prompting the doctor and waiting
for input before proceeding to the next line. So when s/he types Typelt4Me will begin by
typing the first line, with the name autocue prompt highlighted ready to be replaced by the
patient’s name:

Patient Details:

Name: name




Our doctor types the patient’'s name, then presses the -1 (tab) key to continue. Typelt4Me
expands the next part of the snippet and prompts for the patient’s date of birth in dd/ mm/ yyyy
format. All the doctor has to do is continue the process, entering details and pressing tab to
progress to the end, at which point the expansion is complete.

Patient Details:

Name: Jon Appleseed
Date of Birth: 22/ 11/ 1984
Height: 6°1”

Weight: weight

So, when you want to use autocue, just remember that when you type your chosen
abbreviation Typelt4Me will expand the text up to the first hourglass symbol, highlight the
“cue” (the word between the scissors and hourglass symbols) and wait for your input. You'll
type the content to replace it and then press -1 (tab) to tell Typelt4Me you’re ready to proceed
to the next part - if there is one. Just repeat as necessary until you’re done.



Using the Snippets submenu, you can embed or “nest” other snippets to appear (expanded of
course) within the expanded text of any given snippet. Just pick it from the list and it will be
inserted wherever you’ve positioned the cursor in the snippet you’re editing.

Time | 2
It Date / Time Math...

Special »

Snippets » br
- ds

eml
eso
hmadd
ht
Ifwd
lor
mynum
opm
rgch
sfdd
svt
t4m
tam
tdd
tdd2w

m Thank you very much for your email
tsh Where they’re inserted in other snippets, in

x"m the editing pane nested snippets look like this:

wbst

o &thxema

#yo



2.14.7 Execute Applescript

If you know how to use AppleScript, you can use Typelt4Me to
execute a script when you type a shortcut. Just create a new

Avbrevialioniceslabel: abb / snippet pair and type or paste your AppleScript code into
opm Open Mail with Zarvox voice . - . .

the snippet editing pane*. Then pull down the Insert > Special
Snippet contents: | Plain text menu and pick Execute as AppleScript.

%tell application "Finder"

open application file "Mail.app" of folder This will place the special symbol % at the beginning of the
"Applications" of startup disk . . . .
snippet, instructing Typelt4Me to pass your snippet along to
say "opening Mail" using "Zarvox" AppleScript for execution instead of inserting it.
end tell
o > For example, you could specify that typing om should open Mail
m Time > and have the built-in OS X voice Zarvox say "opening Mail":
t(s): | Default ‘ Date / Time Math...

BT Postion cursor here

‘ Snippets | 2 <] (Type a Backspace)
- (Type a TAB)
1+ (Type a TAB left)
<J (Type a Carriage Return)

88 (Paste Clipboard Here)

% (Execute as AppleScript)

$<autocue 5

Append Trigger

: : *Note: take extra care with inverted commas. These must be straight ("), not
Don't Append Trigger

curly (), otherwise you will run into an error when your Mac attempts to
execute the Applescript.
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2.15 - Preferences

Many of Typelt4Me’s features can be customised to suit your own personal requirements. You can
tinker with them to your heart’s content via the Preferences section. Don’t want spaces to trigger
expansion? Looking to disable Typelt4Me completely in certain apps? Perhaps you’d like to tweak
spellchecking or have a sound play when abbreviations expand. It’s possible to do all that and a
whole lot more. The Preferences section is where you’ll set everything up just the way you like it.

The app’s preferences are organised under these seven tabs:
General - Triggers - Expansion - AutoCorrect - Special - HotKeys - Sync

m. Triggers  Expansion  AutoCorrect Special HotKeys Sync

Over the next few pages, we’ll explore the various options available to you. If some of this sounds a
little jargon-y, don’t worry too much about trying to understand and retain what everything does. As
long as you get the gist of the kind of things Typelt4Me can do, you can always refer back to this
section later and experiment when there’s something specific you’re trying to achieve. Chances are,
you’ll leave most of the default settings unchanged.



automatically open every time you log in to your Mac
(we recommend leaving this option enabled).

display your snippets in the menu bar so you can browse
through them and retain the option to insert snippets by

point-and-click in addition to expanding typed abbreviations.

display the app icon in the dock, in the menu bar or in both.
(NB: the floating search window feature outlined in section
2.13.4 is only available when Typelt4Me is set to appear in
just the menu bar. Make sure the middle radio button is
selected if you plan to use search).

Use a different expansion method for shorter plain text
snippets. By default, Typelt4Me works by copying and
pasting your snippets to and from the Clipboard on the fly. If
you’re working in an environment that inhibits or interferes
with pasted input and this appears to be causing problems
with Typelt4Me, tick the “Don’t use the Clipboard...” option
here. It will bypass the clipboard and expand snippets
another way*.

The first Preferences tab - “General” - groups together an array of high level options.
Here you can specify whether or not Typelt4Me should:

coucclly Triggers  Expansion

Automatic launching:

# Open Typelt4Me at Login

Icon display:

Show Typelt4Me in: Dock

Clipboard usage:

Don't use the Clipboard
when expanding plain text
snippets shorter than

30 | characters.

AutoCorrect

Special HotKeys

Typelt4Me in the menu bar:

Sync

Show point-and-click snippet list(s)

© Menu bar

Dock & Menu bar



Under the Triggers tab you’ll find a set of checkboxes you can use to choose one, several or even
all of 35 different keyboard characters that will act as triggers and cause your abbreviations to be
expanded as you type. To add or remove a trigger, just tick or untick the checkbox next to it.

This picture shows the default setting, which is that typing a - (tab)
or space will trigger expansion. Use the All or None buttons to
quickly select or deselect all check boxes.

General pHiiccCely Expansion  AutoCorrect Special HotKeys  Sync

Select the delimiters that should trigger the expansion:

! # $ % &

- ' Expansion without typing a trigger:

? < > ( )

If you select None, abbreviations will expand immediately as soon
as they are typed, without the need to type a trigger. Should you

@ TAB @ Space  Return | nbs esc ~ : elect to go with this setting, you will need to ensure that no two
abbreviations start with the same letters. Otherwise, the shorter one

will trigger as soon as you type it, every time.

@ [ 1 { } \ /

All None



Go to the third preferences tab if you want to tinker with settings that govern how Typelt4Me
behaves when expanding your snippets. There are eleven checkbox options from which to

choose. We'll give you a rundown of what each one does.

Disable keyboard expansion

This is fairly self-explanatory. If you check this box, Typelt4Me will no
longer expand your abbreviations automatically as you type. You’ll only
be able to expand abbreviations using the point-and-click menu list.

Don’t append trigger

You should check this if you don’t want the character that triggers
expansion (e.g. a space) to be added to the end of expanded snippets.

Case sensitive expansion

If you check this option you will have to type your abbreviations in
exactly the same upper and / or lower case format in which they were
defined or they won’t be expanded. Note that Typelt4Me will still alert
you if you attempt to define two identical abbreviations, even if you
type them in a different case. So, if “ty” already exists, Typelt4Me will
intervene to remind you if you later try to define a “TY” abbreviation.

General  Triggers

Expansion preferences:

Disable keyboard expansion

Don't append trigger
Case sensitive expansion
Don't match Abb Case
Strip 's' for plurals

Play sound on expansion
Don't Restore Clipboard
Highlight abb to replace

Ignore leading characters

AutoCorrect  Special HotKeys

Extras:

No DOuble CAps

Capitalise new sentence

All punctuation resets abb

Available sounds

Basso
Blow
Frog
Funk
Glass

Harn

Sync




Don’t match Abb Case

By default, if you type an abbreviation starting with a Capital letter
or in ALL CAPS then Typelt4Me will expand the snippet accordingly,
so that it starts with a Capital letter or is typed in ALL CAPS. If you
check it, the “Don’t match Abb Case” option stops that from
happening.

Strip ’s’ for plurals

The “strip ’s’ for plurals” setting enables you to define an
abbreviation only once to cover both singular and plural forms. If
you check this option, typing an abbreviation and adding an s to
the end before triggering it will result in the expanded snippet also
having an s at the end.
Suppose you define as . Without this option, you
would also have to define to produce . Either
that, or you would have to type , then a space to trigger the
expansion to , then a backspace and finally type an
at the end of . Instead, if you choose to strip s for
plurals, you'll be able to type and see it expand to

, without the need to define separately.

General  Triggers L2GEREEnl]  AutoCorrect Special HotKeys

Expansion preferences:

Disable keyboard expansion

Don't append trigger
Case sensitive expansion
Don't match Abb Case
Strip 's' for plurals

Play sound on expansion
Don't Restore Clipboard

Highlight abb to replace

Ignore leading characters

Extras:

No DOuble CAps

Capitalise new sentence

All punctuation resets abb

Available sounds

Basso
Blow
Frog
Funk
Glass

Harn

Sync



Play sound on expansion

Select this option if you’'d like to hear a system alert sound every time you trigger an expansion.
When the checkbox is ticked, a list of available sounds will appear for you to choose from. Power
users with lots of abbreviations may be driven crazy by constant beeping, but if you only use text
expansion sparingly and tend to look at the keyboard rather than the screen while typing, it can be
useful for alerting you to typos triggering unintentional expansion, for example.

Don’t restore Clipboard

Very rarely, you may run into an issue which causes Typelt4Me to
misbehave and consistently produce the contents of the clipboard
instead of the snippet corresponding to the abbreviation you

General  Triggers L2EnE el AutoCorrect Special  HotKeys

typed. It can happen on older, slower Macs or when many apps S e

are open, causing event handling to slow down. Selecting the Disable keyboard expansion No DOuble CAps
“Don’t restore Clipboard” option will prevent this and ensure you Don't append trigger Capitalise new sentence
always get the right snippet expansion. We don’t recommend Case sensitive expansion All punctuation resets abb
using this feature unless you have to, however, because it does S

mean every time you expand an abbreviation you’ll lose anything
that was copied to the clipboard.

Strip 's' for plurals

Play sound on expansion Available sounds
Don't Restore Clipboard SaEEn
Blow
Highlight abb to replace
Frog
Hilite abb to replace Ignore leading characters Funk
Glass
Tick this checkbox if when you undo (cmd-z) an expansion you’d Hern

prefer to see the abbreviation you typed come back, highlighted
and ready to be replaced with something else.

Sync



Ignore leading characters

When this is selected Typelt4Me will expand your snippet even if its
triggering abbreviation is immediately preceded by non-whitespace
characters. This feature was requested for a very specific use case;
you probably won'’t need it.

No DOuble CAps

This feature prevents you from typing two or more consecutive
letters in uppercase. If you turn this option on, you will have to press
the capslock key to type OK, US, USA, NASA, etc. Backspacing
over a letter that has been turned to lowercase will allow you to re-
type it in uppercase.

Capitalize new sentence.

General  Triggers L2GEREl  AutoCorrect Special HotKeys

Expansion preferences:
Disable keyboard expansion
Don't append trigger
Case sensitive expansion
Don't match Abb Case
Strip 's' for plurals

Play sound on expansion
Don't Restore Clipboard
Highlight abb to replace

Ignore leading characters

Turning this on will automatically turn the first letter you type after pressing return to uppercase.
Ditto for letters typed after a . ! or ? but only when they are followed by a space. Note: when
typing the first letter in a new document, it will not be capitalized because Typelt4Me can only do

Extras:

No DOuble CAps

Capitalise new sentence

All punctuation resets abb

Available sounds

Basso

Blow
Eﬁﬂ!ﬂ!‘l‘l‘l‘l‘l‘l‘l

Frog

Funk

Glass

Harn

Sync

Important note: the three “Extras”
options may have undesirable side
effects in certain exceptional
circumstances. The bottom line is: if
they work for you, turn them on. If you
are unhappy with their behaviour, just
turn them off. They're entirely optional.

so when it “watches” you type punctuation. This isn’t a bug, it’s a normal feature constraint.

All Punctuation Resets Abb

Enable this option if you want Typelt4Me to expand abbreviations even when they are typed
immediately after a punctuation mark.



Typelt4Me is primarily concerned with expanding your custom defined abbreviations to longer
snippets of content. Your abbreviations will of course not be dictionary words themselves, so it
might not be the best idea for the app to second guess everything you ever type. That said, it
does offer two flavours of AutoCorrect functionality, accessible under the fourth preferences tab.

General  Triggers  Expansion

Correct typos with AppleSpell
No audio feedback
© Beep on correcting a typo
Speak the corrected word
Available sounds
Basso

Blow
Bottle

Funk
Glass

Hern

Correction probability:

Lower - Higher

Show the language setting in the menu bar

Correct typos using AutoCorrect Dictionary:

Special HotKeys  Sync

TidBITSAutoCorrect w

Ignored words: 3

riccardo
TypeltdMe
wi-fi

+
Also ignore any words

with 4 or fewer letters or

starting with a capital.

Since these days macOS already does a pretty good job of
spellchecking, both of Typelt4Me’s AutoCorrect options are
switched off by default. You can opt to enable just one or
choose to have both active at the same time; they’re
complementary to each other.

If you type something that’s not a dictionary word and it’s not a
defined abbreviation in your active snippet set, either, that’s
when AutoCorrect kicks in. When both options are enabled,
Typelt4Me will first look up your typo in the TidBITS
AutoCorrect Dictionary (a compendium of commonly misspelt
words). If it doesn’t find it there, it will ask AppleSpell (the built-
in macOS spell checker provided by Apple) to make a
suggestion for correction.



If you place .typeit4dme snippet sets in ~/Library/Application Support/Typelt4Me/AutoCorrect/ they
will be listed in the popup menu, allowing you to easily change from one to another. By default,
the menu includes the public domain file made available by TidBITS.

When you tick the Correct typos with AppleSpell checkbox, a number of extra options will appear
in the window: No audio feedback, Beep on correcting a typo and Speak the corrected word.

&4 Correct typos with AppleSpell

© No audio feedback
Beep on correcting a typo
Speak the corrected word

You can use the slider to fine tune how
different the suggested correct word can
be in relation to your typo. Different users
will be better served with different settings
to match the kind of typos they’re prone to
making. We recommend experimenting
until you find the setting that suits you.

We recommend you turn on audio feedback,
preferably by having Typelt4Me speak the
suggested correction. On selecting either Beep... or
Speak..., you will be presented with a choice of
system alerts or system voices.

Correction probability:

Lower """ Higher



To tell Typelt4Me to leave a specific word alone, add the word to the ignored
words list. To add a word, click the + button and type the word. To remove a

word from the list, select it by clicking on it, then click the - button.
Ignored words: 3

riccardo

Typelt4Me

wi-fi ...You may not want to keep opening up Typelt4Me’s AutoCorrect preferences
every time you need to add a word to ignore. Should that be the case, you
can define a HotKey to use as a shortcut. The next time Typelt4Me
AutoCorrects a word that should have been left alone, press cmd-z (undo)
and while the word you want Typelt4Me to ignore is highlighted, press the
HotKey; the word will be added to the ignored words list.

_|_

Also ignore any words _ ,
Finally, you can also tell Typelt4Me to ignore words that are shorter than a

with * 4 or fewer letters or minimum length that you specify, or those that you type with a capital letter,

starting with a capital. such as proper nouns and acronyms.

Note that AutoCorrect is probably not suited to everyone. It very much depends on the speed and
style of typing of each individual. If you find it doesn't suit your needs, even after tweaking all the
settings, just turn it off. Also note that for AutoCorrect to work, you must select at least one trigger
(space for example) in the Triggers preferences dialog tab.



AutoCorrect in multiple languages

If you assign a hot key for toggling AutoCorrect on and off and have also enabled more than one
language in Language & Region System Preferences, Typelt4Me will cycle through the top three
languages in the list when you press the hot key.

Autocorrect On/Off: F5

Language & Region preferences contro
and the formats of dates, times, and ci

For example, if you set F5 as the AutoCorrect hot key and your list of languages
is like the one pictured here, pressing the hot key will switch from English (U.K.)

to Frangais. Pressing it again will switch to Deutsch. One more press on the hot e [

key will turn AutoCorrect off. The next press on the hot key will bring back British E:\g‘li:\h‘(g-iﬁ.’) ,
English, starting a new cycle. If you tick the “Show language settings in the menu Fr:;n;;afs R -
bar” box in your AutoCorrect preferences, your current language setting will be French
displayed next to the Typelt4Me icon, like so: Deutsch
Italiano
Peritsh = o) L Q = Espafiol
+

Note that when you make changes to the Preferred Languages list in System
Preferences, you will need to relaunch Typelt4Me for the changes to take effect.
The languages AppleSpell can check are: English, French, ltalian, Spanish,
German, Dutch, Swedish and Portuguese.



The Special preference tab is where you can assign special behaviours to Typelt4Me for when
you’re typing in specific apps. For each app listed (added by drag and drop or using the + button),
you can either assign a specific snippet set to use exclusively or you can tell Typelt4Me not to
expand at all while you’re typing in that app. To remove an app, select it and click the - button.

@® Typelt4Me

Preferences Print Help Stats Register

General  Triggers Expansion  AutoCorrect W HotKeys  Sync

By default, all abbreviations in all active snippet sets will expand in all apps. Here you
can specify different behaviours that will be unique to specific apps. For example,
you can specify that abbreviations should not expand in iTunes. Or, you can specify
that you only want snippets from one specific set to expand when using Pages. Just
drag or add an app into this list to instruct Typelt4Me to make a special exception
and behave differently in that app. Click and hold the arrows for a pop-up menu in
which you can specify ‘Do not expand’ or ‘Expand using...’ and pick a specific
snippet set to use with the app.

Application Special Behaviour
@ 1Password 6.app £ do not expand
@ Contacts.app £ do not expand
B Dictionary.app £ do not expand
+
Done

Turn Typelt4Me off in a specific app

Perhaps you never want Typelt4Me to expand your abbreviations when you’re

typing in, say, your password manager app. Just add it to the list using the +
button. Leave the Special Behaviour field on the default setting, “do not expand”.

Associate a snippet set with a particular app

You can tell Typelt4Me to expand abbreviations only from one specific snippet
set when you’re typing in a particular app - i.e. not necessarily the currently
active set(s). To do this, add the app to the list using the + button, then either
drag the snippet set file you wish to associate with the app onto the Special
Behaviour column next to the application’s name, or click the arrows in the
middle column and select “expand using...” and locate the file.

Application Special Behaviour

n TextEdit.app v do not expand
expand using...



Rather than constantly move your mouse or trackpad pointer to click on the Typelt4Me menu, you
may wish to use quick keyboard shortcuts to initiate certain Typelt4Me actions. To set these up,
head to the sixth preferences tab, HotKeys. Here you can define up to six “hot” keys that when

pressed will invoke the following menu options:

+ Add a snippet
+ Manage snippets

+ Search snippets

+ Pause/Resume expansion
+ Add a word to the ignored words list

« Toggle AutoCorrect on/off

+ Go to TypeltdMe’s Preferences

General  Triggers  Expansion

Hot keys:

Add a snippet:
Manage snippets:

Search snippets:

Pause/Resume:

Add Word to Ignore:

Autocorrect On/Off:

Preferences:

AutoCorrect  Special | HotKeys B

F1
Click to record shortcut
X/
Click to record shortcut
Click to record shortcut

F5




The seventh preference tab is where you'll find options for sharing
and syncing your Typelt4Me snippets across multiple Macs and
devices, either via the cloud or via a shared local network folder. If
you've installed a cloud syncing service on your Mac, you can
enable it here to activate the remote / cloud sets pane in the main
app window. You'll then be able to save snippet set(s) in your
preferred cloud or shared folder and use the same set(s) with more
than one machine. The available sync options are as follows:

+ Nosync
+ iCloud Drive
+  Dropbox

+ Google Drive

« Other...

General  Triggers  Expansion  AutoCorrect  Special = HotKeys [Eiiiony

By default, Typelt4Me sets are created and stored locally on your Mac. If you'd
like to sync snippets across multiple devices, you can also opt to use your
preferred cloud syncing service, or a shared remote folder on your local network.

Pick a remote sync option:
No sync
© iCloud Drive
Dropbox

Google Drive

Other...

The Dropbox and Google Drive apps must be running and logged in for your snippets to sync with
those services. On launch, Typelt4Me scans for Dropbox and Google Drive folders in their default
locations on your Mac. If you have moved the Dropbox or Google Drive folder from its default
installation location, then that service will appear greyed out in the sync options list. In this case,
Typelt4Me just needs a little help: select the Other... option, locate the folder and you’re good.



2.16 - How to uninstall Typelt4Me

Should you ever wish to completely remove Typelt4Me from your Mac, it’s a relatively
straightforward process. Just follow these steps to banish all traces of it for good:

«  Quit the app (if it's running).
+ Locate the Typelt4Me app icon in your Applications folder and move it to the trash.

+ Locate the file and move it to the trash.
(This file is located in the Preferences folder in your user library. In OS X Lion and later Apple
hides the user library, but you can reveal it by clicking Go in the Finder menu bar and holding
down the alt key on your keyboard.)

+  Empty the trash.

This will completely remove Typelt4Me and your Mac will forget it was ever installed. If you later
change your mind and re-install Typelt4Me you’ll need to re-enter your licence code to prevent it
regularly popping up messages asking you to register.



A lot of hard work has gone into ensuring your Typelt4Me experience will be as trouble-free as possible. That
said, every app ever developed has the odd hiccup and Typelt4Me is no exception. If you run into trouble, we
are of course happy to help wherever we can. First, though, we recommend that you consult this
troubleshooting section before contacting us; it could help resolve your issue more quickly. What follows is a
list of common issues you may encounter, together with potential solutions.

3.1 - Common issues and their solutions

If every time you restart or log in to your Mac you find that Typelt4Me is not running but you’d like
it to launch automatically, there’s a simple solution. Launch Typelt4Me and go to Preferences,
then tick the checkbox at the top that says “Open at Login”. With that option selected, you’ll never
have to launch Typelt4Me manually again.



3.1.2 Typelt4Me is running but not expanding abbreviations

Sometimes, people report that Typelt4dMe was working normally but then inexplicably stopped
expanding abbreviations. There are a number of potential causes. If this happens to you, before
contacting support you may want to try these troubleshooting steps, testing to see if expansion
works again after each step:

1. Go to System Preferences > Security & Privacy > Accessibility
and make sure the checkbox next to Typelt4Me is ticked.

@ Typelt4Me.app
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Restart your Mac

Check that the abbreviation(s) you have defined does not contain any delimiters (space, etc)
that you also defined as triggers

Try turning all delimiters ON (click on All) in the Triggers section of Typelt4Me’s Preferences

® Typelt4Me

] — W» Y.
Preferences Print Help Stats Register

General |dlsel=&50 Expansion  AutoCorrect  Special  HotKeys  Sync

Select the delimiters that should trigger the expansion:
: # $ % & ' "
. & - , - 9_ .
: ; ? < > ( )
@ [ 1 { B} \ @/

TAB Space [ Return @ nbs esc ~ )

AL None

Trigger on period (.) followed by another delimiter

Done
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NON Typelt4Me

=N R

Preferences Print Help Stats Register

Try turning all delimiters OFF (click on None) in the Triggers section of Preferences, then quit
Typelt4Me, relaunch it and select the =1 (TAB) and Space delimiters.

oe Typelt4Me

0 S0l £

f
Preferences Print Help Stats Register

Select the delimiters that should trigger the expansion:

! # $ % &

= ., - 9, =

\‘- fr C >

@ JI 1 K )3
| | TAB | Space Return nbs | lesc

~ | Trigger on period (.) followed by another delimiter

Done

General lilslcls&sin  Expansion AutoCorrect Special

All

HotKeys

None

i Sync

General |uigls[e=le Expansionr AutoCorrect

Select the delimiters that should trigger the expansion:

H # $ %

[ + = ],
; 2 <

@ i (1 I

2 TAB [ Space = Return  nbs

Done

6. Restart your Mac again

Special

esc

All

HotKeys  Sync

None
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7. Go to the Expansion tab of Typelt4Me’s Preferences and make sure that the first checkbox,
“Disable keyboard expansion”, is not selected. It may have been ticked by accident.

@ Typelt4Me
— ¥ &«
Preferences Print Help Stats Register

General  Triggers AutoCorrect  Special HotKeys  Sync

Expansion preferences: Extras:

Make sure this

option is NOT —» | Disable keyboard expansion No DOuble CAps

selected. . .
Don't append trigger
Capitalise new sentence

| Case sensitive expansion -

- All punctuation resets abb
Don't match Abb Case

~ | Strip 's' for plurals
Play sound on expansion

| Don't Restore Clipboard

| Highlight abb to replace

Ignore leading characters

Done

If you've tried all these steps and Typelt4Me still won’t expand your abbreviations,
please email support@ettoresoftware.com
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If you're not seeing the Typelt4Me icon in your menubar, don’t panic. There are three possible causes,
each with a very simple explanation and fix:

+  Firstly, Typelt4dMe may not in fact be running, in which case you simply need to relaunch it by double
clicking it in your Applications folder (or clicking it in the dock if you keep it there).

+ Secondly, you may have specified in Typelt4Me's preferences that the menu bar icon should not be
visible. Long-press on Typelt4Me in your dock, then navigate to Preferences > General and in the
icon display section make sure Typelt4Me is set to show either in ‘Menu bar' or in ‘Dock & Menu
bar’ (i.e. select the second or third radio button).

+ The third possibility is that - though it's still running - Typelt4Me's icon is being hidden because the
menubar has become crowded and there are a lot of other items displayed to the right of it. Menubar
overcrowding can come about when your screen is not wide enough to accommodate all your icons
as well as all the menu options for the current application in use. MS Word and other Office
applications have lots of menubar options, so you may find this happens when using them.

Fortunately, there are ways to save space and mitigate this. In macOS Sierra and later, you can hold
down the cmd key and then drag your menu bar icons to rearrange them. You could also go into
'System Preferences' > 'Users & Groups' > 'Login Options' and change the fast user switching menu
to display as 'lcon' or 'Short name' instead of 'Full name'. Another space saving trick could be to
change the way the date and time are displayed. If you've tried both of these and there still isn't
enough space for you to see the Typelt4Me icon, you could also quit some other less frequently used
apps that perhaps live in your menubar and then relaunch them so that the Typelt4Me icon moves
further over to the right and will be more likely to remain visible at all times.



If you’ve been using sets stored in iCloud Drive, the first time you launch Typelt4Me 6.x after updating
from version 5.5.x it will automatically move your sets to a new, hidden iCloud folder. This is because the
newest version of Typelt4Me now makes use of a different iCloud implementation that can sync with
Typelt4Me Touch for iOS. This migration ought to be seamless in most cases, but it’s possible something
may prevent Typelt4Me from handling it for you. If this happens, you’ll see the following popup message:

An error occurred while moving your sets to
the updated iCloud location. Please see

X point 3.1.4 of the Troubleshooting section of
the User Guide.

When you see this message, it most likely means there is already a set with the same name in the new,
hidden iCloud folder (possibly created by one of your other Macs, or by Typelt4Me Touch on one of your
iOS devices). Don’t worry, the file is not lost, it just got stuck in a temporary folder en route to its intended
destination. You'll find it in your home directory, in a folder named “Typelt4Me(temp).” Here’s what to do:
1. Rename the file in Finder, giving it a new, unique name (even just appending a number will do).

2. Double click it. It will automatically be moved to “Sets on this Mac” in Typelt4Me.

3. In Typelt4Me, drag the renamed set from “Sets on this Mac” to “Sets in iCloud Drive.”



If you’re familiar with Macs and OS X in general then hopefully the language used to describe
how Typelt4dMe works won’t sound too much like alien gobbledegook. We’ve tried to keep it as
simple as possible and limit the amount of jargon for you to decipher. The following is a short list
of explanations for terms used in a context that’s quite specific to Typelt4Me.

Text expansion

Text expansion is essentially automatic on-the-fly substitution of
short typed abbreviations with ‘snippets’ of content. Its name
derives from the fact that these snippets are usually longer than
the abbreviations they replace and thus ‘expand’ upon them,
producing lengthy words, phrases, reams of boilerplate text or
even pictures.

Text expander

A text expander is a software application that executes text
expansion, automatically replacing custom defined abbreviations
on the fly with snippets of text and / or pictures.



Snippet (aka clipping)

Snippet refers to the full text and / or picture(s) that Typelt4Me
will automatically insert in your document when any given
abbreviation is expanded. It may also refer to the full contents of
an expansion together with its corresponding abbreviation as a
defined pairing constituting a single unit, e.g. “there are 15
snippets in the set” can mean “there are 15 abbreviation /
snippet pairs in the set”. In earlier versions of Typelt4Me
shippets were referred to as “clippings”, because they are items
of content that are copied to and from the Mac’s clipboard.

Abbreviation (aka shortcut)

This is the text you will type (or pick from a list in the Typelt4Me
menu) in order to have a snippet “expanded” (inserted at the
cursor) in the document or text field in which you’re typing.

Snippet set

In Typelt4Me a snippet set is a file containing a list of
abbreviations and their corresponding snippets. In the Mac
Finder these appear as files with the extension “.typeit4me”.
They’re stored in a Sets folder in Typelt4Me’s Application
Support folder within your User Library.



Trigger

A trigger is a key on your keyboard that when typed directly after
a Typelt4Me abbreviation will cause it to be expanded. There
are a total of 35 potential trigger keys from which you can
choose. Most of them are punctuation keys and symbols.

Delimiter

A delimiter is a punctuation or symbol character that can be
used as a trigger for expanding typed abbreviations.

Sync / syncing

Sync is short for synchronise / synchronisation. Where we refer
to “sync services” and “sync options”, we mean services like
iCloud Drive, Dropbox and Google Drive. Keeping your snippet
sets in sync across multiple Macs means ensuring that changes
made to a snippet set on one Mac are automatically available on
all your other Macs that have been set up to use the same sync
service and set.



This guide is designed to provide you with a solid understanding of how Typelt4Me works.
Hopefully you’re already well on your way to saving time and effort that would otherwise be spent
needlessly grinding away at your keyboard. If there’s anything in this documentation that you find
unclear, please do get in touch to let us know. We’re also happy to help if you run into problems
that don’t appear to have been covered here.

Please bear in mind that we are a very small team, so if you contact us during an exceptionally
busy period it may sometimes take a little while for us to reply. It’s always a good idea to first
check the troubleshooting section of this guide (page 81) and the Typelt4Me Frequently Asked
Questions section at the Ettore Software website. 9 times out of 10 any problem you've
encountered will be a known issue with a documented solution or workaround.

There’s an extensive online FAQ available at

If you have questions that aren’t covered in the FAQ or you've run into a problem and can’t find a
fix anywhere, please send an email to


http://faq.typeit4me.com
mailto:support@ettoresoftware.com
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